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学习完本章后，应该能够学会安装ANSYS，并掌握GUI界面

的基本功能及基本分析步骤.Module

Objective

Lesson A.  安装ANSYS  

Lesson B.  启动ANSYS

Lesson C.  ANSYS的图形用户界面

Lesson D.  基本的交互操作

Lesson E.  ANSYS的帮助系统

Lesson

Objectives

ANSYS安装与图形用户界面（GUI）



• 从工大 ftp://202.118.224.241或ftp://peri.hit.edu.cn 等ftp网站下载软件。

• 一般为.iso文件，为虚拟光盘文件，可安装Daemon tool等虚拟光驱软件
后，将.iso文件加载。

• 安装 ANSYS

– 主程序安装：安装过程中会生成c:\program files\Ansys Inc目录

– license生成：在虚拟光驱中找到MAGNiTUDE目录，运行该目录中的
ap120_calc.exe，生成license.dat文件 （在弹出的命令行窗口中，输入Y后自
动生成）

– 将生成好的license.dat文件拷贝到c:\program files\Ansys Inc\shared 
files\licensing 目录中。

安装ANSYS

ftp://202.118.224.241/
ftp://peri.hit.edu.cn/


Ansys 12.0 安装方法

下载安装文件：
对于Ansys 12，有一个约3.7G大小的ISO镜像。
对于Ansys 13.0及更高版本，需要下载两个镜像。

ftp://202.118.224.241/software/Engineering.General/CAE/ANSYS/

ftp://202.118.224.241/software/Engineering.General/CAE/ANSYS/


Ansys 12.0 安装方法

用虚拟光驱装载下载好的iso格式镜像文件，或者用解压缩工具
直接对iso文件进行解压。可以查看该光盘文件的内容如下：



Ansys 12.0 安装方法

在光盘中找到MAGNiTUDE文件夹，打开该文件夹。



Ansys 12.0 安装方法

MAGNiTUDE文件夹：双击运行ap120_calc，弹出的窗口中输
入Y，将自动生成License文件。



Ansys 12.0 安装方法

回到安装文件的主文件夹，运行setup.exe开始安装



Ansys 12.0 安装方法

在Win7系统中，应使用右键菜单中的“以管理员身份运行”安
装程序



Ansys 12.0 安装方法

弹出安装菜单，按照从上至下的顺序，先点击第一个按钮
“Install Required Prerequisites”，安装ANSYS所需的运行环
境。



Ansys 12.0 安装方法

Ansys Prerequisites里包含VC++ 2005 Redistributable、VC++ 

2005 SP1 Redistributable、.NET frameword 2.0 SP1。
依次进行安装。
某些组件安装后可能需要重启计算机再继续其它安装步骤。
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Ansys 12.0 安装方法

如果提示出错，按照下面几页操作：



Nov., 2013

1-13

Ansys 12.0 安装方法
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Ansys 12.0 安装方法
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Ansys 12.0 安装方法



Ansys 12.0 安装方法

安装完Prerequisites后，回到安装菜单，点击第二个按钮
“Install ANSYS Inc. Products”，开始安装ANSYS主程序。



Ansys 12.0 安装方法

点击”I AGREE”，然后”NEXT”



Ansys 12.0 安装方法

可以修改Install Directory(安装目录)到其它磁盘分区。



Ansys 12.0 安装方法

选择需要安装的ANSYS产品部件。一般默认即可，无需改动。



Ansys 12.0 安装方法

设置ANSYS与其它程序的关联，一般可以先勾选底部的跳过
(skip)，以后有需要的时候再关联。



Ansys 12.0 安装方法

确认刚才的设置，点NEXT开始安装



Ansys 12.0 安装方法

开始安装，需要解压缩100个安装包，所以时间比较长。



Ansys 12.0 安装方法

开始安装，需要解压缩100个安装包，所以时间比较长。



Ansys 12.0 安装方法

安装过程会播放历年的ANSYS版本更新介绍。



Ansys 12.0 安装方法



Ansys 12.0 安装方法



Ansys 12.0 安装方法

安装完成后，按提示点击”NEXT”，准备进行客户端最后的配置



Ansys 12.0 安装方法

在如下的对话框Hostname1中，填入计算机名。计算机名可从”

我的电脑（WIN XP）/计算机(WIN 7)”属性中找到。



Ansys 12.0 安装方法

Win 7的计算机名查看方法：
桌面，右击”计算机”，属性，



Ansys 12.0 安装方法

Win XP的计算机名查看方法：
桌面，右击”我的电脑”，属性，计算机名，完整的计算机名称



Ansys 12.0 安装方法

程序根据提供的计算机名自动配置。完成后点击Exit退出。



Ansys 12.0 安装方法

点击NEXT，回到安装菜单，点第3项，安装证书管理服务。



Ansys 12.0 安装方法

类似主程序的过程，AGREE用户协议，修改安装路径，开始展
开文件，一路点击NEXT，直到出现证书安装向导。



Ansys 12.0 安装方法

点击几次Continue后，弹出对话框，要求指定License文件。选
择为之前MAGNiTUDE生成的License。



Ansys 12.0 安装方法

成功导入了证书后，经过几个Continue和Next，完成License 

Server的安装，回到主菜单，点EXIT结束安装。



Ansys 12.0 安装方法

在开始菜单里找到“Mechanical APDL (ANSYS)”，点击，启
动ANSYS，开始你的建模分析吧！



ANSYS 入门

• 在本章中,我们将讨论怎样进入和退出 ANSYS,怎样运用 GUI方式
和在线帮助,如何用 ANSYS生成数据库和文件等一些基本分析步骤
。

• 主题:

A. 启动 ANSYS

B.  GUI方式

C.  显示图形拾取功能

D.  在线帮助

E.  数据库和文件

F.  退出 ANSYS

G. 练习



ANSYS 入门

A.  启动 ANSYS

• 有两种方式启动 ANSYS:

– 通过交互方式

– 通过命令

交互方式

• 通过菜单上的相应按钮启动 ANSYS 

• 在Unix 系统中, 进入 xansys57 & 导出操
作平台。

• 在Windows 系统中, 按 Start > Programs 

> ANSYS 5.7。

Unix 

平台

Windows

平台



ANSYS入门

…启动 ANSYS

启动 (cont’d)

• 当ANSYS 以交互方式启动后，用户图形界面（GUI）将自动显示。

• 交互方式与批处理模式的比较:

– 交互方式允许与ANSYS面对面的“交流”,检查您的每
一步操作

– 批处理方式 以输入命令文件的方式工作，允许在后台
运行 ANSYS 。

• 如果不采用交互方式,输入文件的错误将导致批处
理终止。

• 例如求解，最好的操作方式是不需要用户干预的。

– 在本学习过程中，我们将主要讲解交互式操作。



ANSYS 入门

…启动 ANSYS

启动 (续)

• 在弹出的 启动对话框中按Mechanical 

APDL Product Launcher按钮:

– ANSYS产品

– 工作目录 –所有文件将要存贮的目录。

– 图形设置 – 如果配置了 3-D显示卡请您选
择 3-D。否则, 在Unix系统上选择 X11 , 

在Windows系统上选择win32.

– 作业名, 不超过 32 个字符, 该作业名将作
为所有生成文件的前缀。缺省为 file或为
上一次定义的作业文件名。

– 内存空间 –缺省值将满足大多数情况



ANSYS 入门

…启动 ANSYS

启动 (续)

• 在弹出的 启动对话框中按Mechanical 

APDL Product Launcher按钮:

– ANSYS产品

– 工作目录 –所有文件将要存贮的目录。

– 图形设置 – 如果配置了 3-D显示卡请您选
择 3-D。否则, 在Unix系统上选择 X11 , 

在Windows系统上选择win32.

– 作业名, 不超过 32 个字符, 该作业名将作
为所有生成文件的前缀。缺省为 file或为
上一次定义的作业文件名。

– 内存空间 –缺省值将满足大多数情况



ANSYS 入门

…启动 ANSYS

启动 (续)

• 在弹出的 启动对话框中按Mechanical 

APDL Product Launcher按钮:

– ANSYS产品

– 工作目录 –所有文件将要存贮的目录。

– 图形设置 – 如果配置了 3-D显示卡请您选
择 3-D。否则, 在Unix系统上选择 X11 , 

在Windows系统上选择win32.

– 作业名, 不超过 32 个字符, 该作业名将作
为所有生成文件的前缀。缺省为 file或为
上一次定义的作业文件名。

– 内存空间 –缺省值将满足大多数情况



ANSYS 入门

…启动 ANSYS

启动 (续)

• 选择您喜欢的启动方式之后，请按键（Run）运行 ANSYS.

命令方式

• 在当前系统下键入一个命令，ANSYS将被启动 。例如:

– ansys57

– ansys57 -g

– ansys57 -g -j plate

– ansys57 -g -p ANE3FL -d 3d -j proj1 -m 128



ANSYS 入门

…启动 ANSYS

命令行 (续)

• 典型的开始选项中，通常命令选择项有:

-g (开始后将自动显示 GUI)

-p 产品代码

-d 图形设备

-j 工作名称

-m 内存

• 工作目录是命令运行的目录。

• 参考ANSYS安装和配置手册获取命令行的详细信息。



ANSYS 入门

…启动 ANSYS

启动 (续)

• 在弹出的 启动对话框中按Mechanical 

APDL Product Launcher按钮:

– ANSYS产品

– 工作目录 –所有文件将要存贮的目录。

– 图形设置 – 如果配置了 3-D显示卡请您选
择 3-D。否则, 在Unix系统上选择 X11 , 

在Windows系统上选择win32.

– 作业名, 不超过 32 个字符, 该作业名将作
为所有生成文件的前缀。缺省为 file或为
上一次定义的作业文件名。

– 内存空间 –缺省值将满足大多数情况



ANSYS 入门

• 在本章中,我们将讨论怎样进入和退出 ANSYS,怎样运用 GUI方式
和在线帮助,如何用 ANSYS生成数据库和文件等一些基本分析步骤
。

• 主题:

A. 启动 ANSYS

B. GUI方式

C.  显示图形拾取功能

D.  在线帮助

E.  数据库和文件

F.  退出 ANSYS

G. 练习



• 进入 ANSYS 后显示如下的 GUI窗口:

输入

显示提示信息，输
入ANSYS命令。能
够方便的获取以前
输入的所有命令。

主菜单

包含主要的 ANSYS 

功能，分为前处理、
求解、后处理等。

输出

显示软件的文本输
出，通常在其它窗
口后面，需要查看
时可提到前面。

功能菜单

包含例如文件管理、
选择、显示控制、参
数设置等功能。

工具条

将常用的命令制成工
具条，方便使用。

图形界面

显示由 ANSYS 创建
或传入ANSYS的图
形。（体现友好）

ANSYS 入门

B.  图形用户界面



主菜单

• 包括分析所需的主要功能。

• 在进行下一个功能之前，重叠的独立窗口允许完成所
有必须的操作。

• 约定:

表示产生一个对话框

表示图形拾取

表示将产生下一个子菜单

ANSYS入门

... GUI方式



ANSYS 入门

... GUI方式

功能菜单

包含ANSYS运行过程中通常使用的功能，如:图形,在线帮助,选择, 文
件管理等.

-- “…”表示产生一个对话框

-- +”表示图形拾取

-- “ >”表示将产生下一个子菜单

-- “ ” (空缺)表示进行一个操作



ANSYS 入门

... GUI方式

输入窗口

• 允许输入命令。 (大多数 GUI功能都能通过输入命令来实现.  如果
知道这些命令,可以通过输入窗口键入。)

• 在拾取图形时也可以通过键入命令的方式实现。

命令格式



ANSYS 入门

... GUI方式

工具条

• 包含常用命令的缩写形式。

• 可使用一些预先设置好的命令，也可以添加自己的命令，但需要熟
悉 ANSYS 命令。

• 构造自己的“按钮菜单”是很有用的！



ANSYS 入门

... GUI方式

版面布置

有三种预先定义的菜单布局。

(Launcher > Interactive > GUI Configuration):

– 输入窗口在左边 (缺省)

– 输入窗口在右边

– 输入窗口在下面

– 也可以创建自己的布局并保存起来。

• Utility Menu > MenuCtrls > Save Menu Layout.

– Unix 系统采用位于$HOME，名为ANSYS57 的ASCII

码源文件存贮。

– Windows系统在系统注册中保存菜单布局。

输入

输入

输入



ANSYS 入门

…GUI方式

优选框

• 优选框 (Main Menu > Preferences) 允

许您过滤掉当前分析中不用的菜单选项
。

• 例如,如果做一个热分析,您可以过滤掉
其它选项,从GUI中可以知道缩减的菜单
项:

– 只有热单元类型将在单元类型选择对话
框中出现。

– 只显示热荷载。

– 等。



ANSYS 入门

... GUI方式

其它 GUI注意事项

• 一些对话框中有 Apply和 OK两种按钮。

– Apply 完成对话框的设置,不退出对话框 (不关闭) 。

– OK完成对话框的设置, 退出对话框。

• ANSYS菜单输出窗口是独立的.  

注意:  在关闭输出窗口时将关闭ANSYS操作！

• 不要局限于用GUI 方式，如果熟悉命令，在输入窗口键入命令会

更方便！



ANSYS 入门

• 在本章中,我们将讨论怎样进入和退出 ANSYS,怎样运用 GUI方式
和在线帮助,如何用 ANSYS生成数据库和文件等一些基本分析步骤
。

• 主题:

A. 启动 ANSYS

B.   GUI方式

C.  显示图形拾取功能

D.  在线帮助

E.  数据库和文件

F.  退出 ANSYS

G. 练习



ANSYS 入门

C. 图形拾取

• 在GUI方式中大量使用图形拾取。

– 图形用于建模，加载，显示结果及输入、输
出数据。

– 拾取对建模，划分网格，加载等是很有用的

• 在应用菜单中可用 Plot 来显示图形及执行命
令后的显示。

/replot

kplot

lplot

aplot

vplot

nplot

eplot

gplot



ANSYS 入门

…图形拾取

• PlotCtrls 菜单是用来控制图形显示的：

– 绘图方位

– 缩放

– 颜色

– 符号

– 注释

– 动画

– 等

• 改变观察方位、图形缩放是最常用的功能



ANSYS 入门

…图形拾取

• 缺省的视图方位是主视图方向：是从 +Z 轴
观察模型。

• 用动态模式（拖动模式）—拖动模式是一种
用 Control键和鼠标键调整观察方向的途径

– Ctrl + L eft( 鼠标左键)可以平移模型。

– Ctrl + Middle(鼠标中键）:

缩放模型

旋转模型 (绕屏幕 Z轴方向)

– Ctrl + Right（鼠标右键）旋转模型 :

绕屏幕X轴方向

绕屏幕Y轴方向
P Z RCtrl



ANSYS 入门

…图形拾取

• 如果不想按住 Control 键,可以用Pan-

Zoom-Rotat 对话框中提供的热键。

– 同样可以用鼠标键来操作。

– 在 3-D图形设置中,您同样可以自动控制光
源 。产生不同角度的光照效果。



ANSYS 入门

…图形拾取

• Pan-Zoom-Rotate对话框的其
它功能:

– 预先设置的观察方向

– 对模型选定的区域进行缩放

– 对模型进行增量式的平移拖动
，缩放以及旋转 (根据滚动条
上设定的比例)

• 分别绕屏幕的 X, Y, Z轴旋
转。

– 缩放模型至适合窗口大小

– 返回模型到默认的取向

Front +Z view, from (0,0,1)

Back -Z view (0,0,-1)

Top +Y view (0,1,0)

Bot -Y view (0,-1,0)

Right +X view (1,0,0)

Left -X view (-1,0,0)

Iso Isometric (1,1,1)

Obliq Oblique (1,2,3)

WP Working plane view

Zoom By picking center of a 

square

Box Zoom By picking two corners 

of a box

Win Zoom Same as Box Zoom, 

but box is proportional 

to window.

Back Up “Unzoom” to previous 

zoom.



ANSYS 入门

…图形拾取

拾取

• 通过点击图形窗口允许选择整体或局部模型
。

• 一典型的拾取操作可用鼠标或拾取菜单来完
成。在菜单中它的标志是一个“ +”号.

• 例如, 可以在图形窗口中关键点的位置处拾
取，然后按 OK键。



ANSYS 入门

…图形拾取

两种拾取方式:

• 恢复拾取

– 拾取已经存在的模型元素。

– 允许在输入窗口键人元素的号码

– 可以用 Pick All热键来拾取所有元
素

• 位置拾取

– 查找一点的坐标如关键点或节点。

– 允许在输入窗口输入坐标。

恢复拾取的例子

位置拾取的例子



ANSYS 入门

…图形拾取

鼠标键拾取功能的分配:

• 左键 拾取 (或取消)距离鼠标光点最近的图
元或坐标。按住此键进行拖拉，可以预览被
拾取（或取消）的图元或坐标。

• 中键 相当于拾取图形菜单中的Apply。 用
中键可以节省时间。对于两键鼠标可以用
Shift加鼠标右键代替。

• 右键 在拾取和取消之间切换。

拾取

应用

拾取和取消的切换

取消拾取

光标显示:



ANSYS 入门

…图形拾取

热点的拾取位置:

• 面和体 有一个热点在图形的中心附近。

• 线 有三个热点 –一个在中间另两个在两端。

为什么这个很重要: 当需要拾取图元时，必须拾取热点。



ANSYS 入门
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ANSYS 入门

D.  在线帮助

• ANSYS 提供了基于HTML格式的帮助系统，作为现有帮助系统的
补充。

• 可以获得如下的帮助:

– ANSYS命令

– 单元类型

– 分析过程

– 特别的 GUI 工具诸如 Pan-Zoom-Rotate

• 也可以进入:

– 指南

– 验证手册

– ANSYS 的网站



ANSYS入门

…在线帮助

• 下列几种方式可以进入帮助系统:

– Launcher > Help System

– Utility Menu > Help > Help Topics

– Any dialog box > Help

– 在输入窗口键入 HELP,name。 Name 是一个命令或一个单元的名称



ANSYS 入门

…在线帮助

• 按 Help System 按钮弹出帮助浏览器：

– 导航窗口包括目录,索引, 搜索引擎和标签

– 一个文件窗口列出了帮助信息。



ANSYS 入门

…在线帮助

• 用 Contents 键可以浏览感兴趣
的内容。

• 用 Index 键可以快速查找具体的
命令,术语,概念等。

• 用 Search 键可以从帮助系统中
查找指定的单词或短语。

• 用 Favorites 键可以添加需要经
常帮助的部分。



ANSYS 入门

…在线帮助

• ANSYS 也提供基于 HTML在
线指导。

• 这种指导包括了在ANSYS 中
求解一系列问题的详细说明。

• 如果想进入指导部分请单击
Utility Menu > Help > 
ANSYS Tutorials.



ANSYS 入门

• 在本章中,我们将讨论怎样进入和退出 ANSYS,怎样运用 GUI方式
和在线帮助,如何用 ANSYS生成数据库和文件等一些基本分析步骤
。

• 主题:

A. 启动 ANSYS

B.   GUI方式

C.  显示图形拾取功能

D.  在线帮助

E.  数据库和文件

F.  退出 ANSYS

G. 练习



ANSYS 入门

E.  数据库和文件

• ANSYS 数据库包括了建模，求解，后处理所产生的保存在内存中
的数据。

• 数据库存贮了输入的数据以及 ANSYS的结果数据:

– 输入数据 – 必须输入的信息,诸如模型尺寸,材料特性以及荷载情况。

– 结果数据 -- ANSYS 的计算结果, 诸如位移,应力,应变以及反力等。



ANSYS 入门

…数据库和文件

保存和恢复

• 既然数据库保存在计算机的内存中，应经常存盘，以防在计算机死
机或断电时能够保存您的信息。

• 保存操作是将内存中的数据拷贝到称为数据库的文件中。 ( db 为
缩写).

– 最简单的保存方式是单击 Toolbar > SAVE_DB

– 或使用:

• Utility Menu > File > Save as Jobname.db

• Utility Menu > File > Save as…

• SAVE 命令



• 从 db文件中恢复数据库,用 RESUME操作。

– Toolbar > RESUME_DB

– 或使用:

• Utility Menu > File > Resume Jobname.db

• Utility Menu > File > Resume from…

• RESUME 命令

• 保存和恢复缺省文件，然后起名为 jobname.db, 但可以通过
“Save as”选择一个不同的名字，然后用 “Resume from”恢复
。.

ANSYS 入门

…数据库和文件



ANSYS 入门

…数据库和文件

• 保存和恢复的注意事项:

– 选择 “Save as” 或 “Resume from” 时并不改变当前的工作名。

– 如果缺省保存在此之前已存在一个重名的文件, ANSYS将首先将旧的
文件拷贝到 jobname.dbb 作为一个备份。

– db 文件仅仅是文件被保存时在内存中的“快照”



ANSYS 入门

…数据库和文件

• 保存和恢复技巧:

– 当做一个分析过程中定期的保存数据库。 ANSYS不能自动保存。

– 在尝试一个您不熟悉的操作时（如布尔操作或剖分网格）或一个操作
将导致较大改变时（如删除操作），应保存数据库。

• 如果不满意此次做出的结果，可以用恢复来重做。

– 在求解之前也应保存数据库。



ANSYS 入门

…数据库和文件

清除数据库

• 清除数据库的操作允许对数据库清零并
重新开始。它相当于退出并重新启动
ANSYS。

– Utility Menu > File > Clear & Start 

New

– 或使用 /CLEAR 命令。



ANSYS 入门

…数据库和文件

文件

• ANSYS 在一个分析中要读写几个文件。文件名的格式为
jobname.ext.

• 工作名

– 在启动 ANSYS之前选择一个不超过 32个的字符作为文件名。缺省为
file。

– 在 ANSYS中，可使用 /FILNAME 命令来修改文件名。 (Utility Menu 

> File > Change Jobname).

• 扩展名

– 鉴别文件的 内容, 例如 .db 是数据库文件。

– 通常由 ANSYS 自己指定，但也可以通过(/ASSIGN)由您自己定义。



ANSYS入门

…数据库和文件

• 典型文件:

jobname.log:日志文件是 ASCII码文件。

• 包括了运行过程中的每一个命令。

• 如果用同样的工作名在同一目录中开始另一轮操作, ANSYS 将会
添加到日志文件中去 (作一个时间标记)。

jobname.err: 出错文件是 ASCII码文件。

• 包括了运行过程中的所有错误和警告。 ANSYS将添加到已存在的
错误文件。

jobname.db, .dbb: 数据库文件是二进制 文件。

• 与所有的平台兼容。

jobname.rst, .rth, .rmg, .rfl: 结果文件是二进制文件。

• 与所有平台兼容。

• 包括了ANSYS运算过程中的所有计算数据。



ANSYS入门

…数据库和文件

文件管理技巧

• 在一个单独的工作目录中作一次分析。

• 用不同的工作名来区分不同的分析。

• 在任何ANSYS分析之后，应保存以下的文件:

– 日志文件 ( .log)

– 数据库文件 ( .db)

– 结果文件 (.rst, .rth, …)

– 荷载步文件, 如有多步 (.s01, .s02, ...)

– 物理文件 (.ph1, .ph2, ...)

• 使用 /FDELETE命令 或 Utility Menu > File > ANSYS File Options

来自动删除ANSYS分析不再需要的文件。



ANSYS 入门

• 在本章中,我们将讨论怎样进入和退出 ANSYS,怎样运用 GUI方式
和在线帮助,如何用 ANSYS生成数据库和文件等一些基本分析步骤
。

• 主题:

A. 启动 ANSYS

B.   GUI方式

C.  显示图形拾取功能

D.  在线帮助

E.  数据库和文件

F.  退出 ANSYS

G. 练习



ANSYS入门

F.  退出ANSYS

• 三种退出 ANSYS的途径:

– Toolbar > QUIT

– Utility Menu > File > Exit

– 使用 /EXIT 命令



第2章 几何实体模型的建立
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实体建模概述

• 直接输入几何实体来建模很方便,但有些情况下需要在ANSYS中来
建立实体模型。例如:

– 没有ANSYS能够读入的几何实体模型时;

– 计算机上没有相关的绘图软件时（与ANSYS程序兼容的）;

– 在对输入的几何实体需要修改或增加时，或者对几何实体进行组合时;

– 多物理场耦合需要传递面荷载时。

• ANSYS 有一组很方便的几何作图工具。本章将讨论这些作图工具.



实体建模概述

区分实体模型与有限元模型

现今几乎所有的有限元分析模型都用实体模型建模. 类似于CAD，ANSYS以数学

的方式表达结构的几何形状，用于在里面填充节点和单元，还可以在几何模型边界
上方便地施加载荷. 但是， 几何实体模型并不参与有限元分析. 所有施加在几何实
体边界上的载荷或约束必须最终传递到有限元模型上（节点或单元上）进行求解.

由几何模型创建有限元模型的过程叫作网格划分（meshing).

Meshing

几何实体模型 有限元模型



几何实体模型和有限元模型的来源

实体建模概述

总共有四种途径创建ANSYS模型（包括几何实体模型和有限元模型），如下表所示：

Option CAD Package ANSYS

A

1.  Build solid model.

2.  Mesh finite element model.

B

1.  Build solid model.

2.  Defeature as needed.

3.  Export solid model.

1.   Import solid model

2.  Complete or modify as

       needed.

3.    Mesh finite element model.

C Build the nodes and elements

directly  as needed.

D

1.   Build solid model

2.   Defeature as needed.

3.  Mesh finite element

      model.

4.  Export finite element

      model.

Import finite element model



实体建模

A.  定义

• 实体建模 可以定义为建立实体模型的过程.

• 首先回顾前面的一些定义：:

– 一个实体模型有体、面、线及关键点组成.

– 体由面围成，面由线组成,线由关键点组成.

– 实体的层次从底到高:  关键点 线 面 体.  如果

高一级的实体存在，则低一级的与之依附的实体不
能删除.

• 另外，一个只由面及面以下层次组成的实体，如壳
或二维平面模型，在ANSYS中仍称为实体.

体

面

线及关键点

关键点

线

面

体



实体建模

A.  定义

• 建立实体模型可以通过两个途径:

– 由上而下

– 由下而上

• 由上而下建模；首先建立体（或面）,对这些体或面按一定规则组
合得到最终需要的形状.

加



实体建模

A.  定义

• 由下而上建模；首先建立关键点，由这些点建立线.

• 可以根据模型形状选择最佳建模途径.

• 下面详细讨论建模途径.



实体建模

B.  由上而下建模

• 由上而下建模；首先建立体（或面）,对这些体或面按一定规则组
合得到最终需要的形状.

– 开始建立的体或面称为图元.

– 工作平面用来定位并帮助生成图元.

– 对原始体组合形成最终形状的过程称为布尔运算.



实体建模 - 由上而下建模

图元

• 图元是预先定义好的几何体，如圆、多边形和球体.

• 二维图元包括矩形、圆、三角形和其它多边形.



实体建模 - 由上而下建模

...图元

• 三维图元包括块体, 圆柱体, 棱体， 球体,和圆锥体.



实体建模 - 由上而下建模

...图元

• 当建立二维图元时，ANSYS 将定义一个面，并包括其下层的线和
关键点。

• 当建立三维图元时，ANSYS 将定义一个体，并包括其下层的面、
线和关键点。



实体建模 - 由上而下建模

...图元

• 图元可以通过输入尺寸或在图形窗口拾取来建立。.

– 例如建立实心圆:

• 前处理 > -建模- 生成 > -面- 圆 > 

指令

拾取器

在图形窗口拾取中心及半径

拾取

或在这里输入数值



实体建模 - 由上而下建模

...图元

– 生成块体:

• Preprocessor > -Modeling- Create > -Volumes- Block > 

V指令

拾取器

在图形窗口
拾取期望的位置...

拾取

…或在这儿输入值



区分图元

打开面编号
的结果

当多个图元同时在图形窗口中显示时，可以通过打开某种图元类型编号来区分它们，这
些图元以不同的标号和颜色显示.



区分图元 (续)

打开编号显示:

Utility Menu:  PlotCtrls > Numbering ...

Procedure

1. .....

2. .....

3. .....

选取需要的项目，
然后选择OK.

控制是否编号和颜
色同时显示 (缺省), 

只显示编号, 或只显
示颜色.



区分图元

需要牢记的

编号显示在图元的“热点
”上.

• 对于面或体，热点为图形
中心.

• 对于线，有三个热点:

..
为什么这一点非常重要: 需要在图形窗口拾取取图元时，应该点取图形的
热点，确保拾取所需要的图元。这对于有多个图形重叠的情况非常重要.

（如上图）



区分图元

关于编号字体的大小

在PC上运行ANSYS，缺省的编号字体比较小，可按下述方法放大：

要放大编号字体:

1.  Utility Menu:  PlotCtrls > Font Controls > Entity 

Font ...

2. 选择需要的字体、尺寸等

3. 选择 OK.

4. Utility Menu:  Plot > Replot

Procedure

1. .....

2. .....

3. .....



删除图元

当删除图元时，ANSYS提供两种选择:

• 可以只删除指定的图元，保留这个图元所包含的低阶图元

• 也可以连这个图元包含的低阶图元一块删去.

只删除面，保留面
上的线及关键点

删除面以及面所包含的低阶
图元（线，关键点）



删除图元(续)

要删除一个或多个图元 :

Main Menu:  Preprocessor > -Modeling- Delete

Procedure

1. .....

2. .....

3. .....

在图形窗口中拾取一个或多个
图元（本例中为面），然后选
择OK..

选择图元(注意前页所
述两种方式）. 



Multi-Plots

使用 Multi-Plots 功能, ANSYS 将在图形窗口同时显示
显示所有数据（包括体、面、线、关键点，以及节点、
单元）.

要使用 multi-plot:

Utility Menu:  Plot > Multi-Plots

Procedure

1. .....

2. .....

3. .....

根据编号对话框中的设置，显示编号及颜色.



实体建模 - 由上而下建模

…工作平面

• 工作平面 — 一个可动的二维参考平面，用来定位确定图元。缺省
状态下，工作平面原点与整体坐标系原点重合，但可以把工作平面
移动或旋转到任意位置.

– 利用显示格栅，在工作平面上作图就象在方格纸上作图。

– 除了格栅的设置外，工作平面是无限的。

WX

WY

X2

X1
Y2

Y1

WXWY

WP (X,Y)



工作平面 (续)

工作平面控制

移动工作平面
的选项

有关坐标系统的选
项 (将在以后的课
程中讨论)

Utility Menu:  WorkPlane >



实体建模 - 由上而下建模

…工作平面

• 所有的工作平面命令菜单均在 Utility 

Menu > WorkPlane.

• 工作平面控制菜单（WP Settings）控制下列
内容:

– WP display - 只显示三个坐标轴 (缺省),只显

示格栅，或两者均显示。

– Snap - 便于在工作平面上拾取格栅上的点.

– Grid spacing – 栅距.

– Grid size -显示的工作平面大小(大小无限制).



工作平面 (续)

要显示工作平面:

Utility Menu:  WorkPlane > Display Working Plane

Procedure

1. .....

2. .....

3. .....

显示工作平面标记，
表示工作平面的原点.



工作平面 (续)

工作平面辅助网格开关:

Utility Menu:  WorkPlane > WP Settings ...

Procedure

1. .....

2. .....

3. .....

选取二者其中任意一
个，显示工作平面辅
助网格，然后选择OK 

或 Apply.



辅助网格间距

改变辅助网格的间距:

Utility Menu:  WorkPlane > WP Settings ...

Procedure

1. .....

2. .....

3. .....

输入间距
值，然后
选择OK 

或Apply.

间距为0.1

间距为 0.05



捕捉功能

在徒手创建几何图元时，捕捉功能用离散的、可控的增量代替光
滑移动，更精确地选取坐标或关键点等.

捕捉功能的特点:

• 捕捉可以打开或关闭.

• 捕捉增量可调.

• 捕捉增量可设置与工作平面间距相等(相当于在坐标纸上绘图).

捕捉开关及捕捉增量.



捕捉功能 (续)

打开或关闭捕捉:

Utility Menu:  WorkPlane > WP Settings ...

Procedure

1. .....

2. .....

3. .....

选取则打开捕捉，不选取则关闭捕捉，然后选
择OK 或 Apply.



捕捉功能 (续)

要修改捕捉增量:

Utility Menu:  WorkPlane > WP Settings ...

Procedure

1. .....

2. .....

3. .....

输入捕捉
增量，然
后选择OK 

或Apply.

图示为使用捕捉功能画矩形，其中捕捉增量等于辅助网格间距.



移动工作平面

工作平面原点的缺省位置与总体坐标原点重合，但可以平移工作平面，
便于创建2D几何模型.

缺省：工作平面原点与总体坐标原点重合. 移动了工作平面以后.



实体建模 - 由上而下建模

…工作平面

• 用Offset 和 Align菜单可以把工作
平面移到期望的任意位置.

– 通过增量移动工作平面

• 用按扭实现 (通过指针滑动实

现).

• 或输入希望的增量值.

• 或使用动态方式 (类似移动-

缩放-转动).



实体建模 - 由上而下建模

…工作平面

– Offset WP to >

保持其当前方向，简单地平移工作平
面到期望的位置:

• 已经存在的一个或多个关键点. 若

拾取多个关键点，则工作平面移到
这些关键点的平均位置处.

• 已经存在的一个或多个结点.

• 通过坐标值指定的一个或多个位置.

• 总体坐标系原点.

• 激活坐标系的原点.



实体建模 - 由上而下建模

…工作平面

– Align WP with >

此命令用于定位工作平面.

• 例如, Align WP with Keypoints 命令
提示拾取三个关键点 - 一个为原点一
个定义X-轴, 一个定义 X-Y 平面.

• 把工作平面移动到其缺省位置（总体
坐标系原点，X-Y 平面内)时, 点击
Align WP with > Global Cartesian.



工作平面及激活的坐标系统

工作平面是2D的绘图板，用于定位

在建模过程中几何项目. 

Main Menu: Modeling > Create > 

Keypoints > On Working Plane +

总体及局部坐标系统（例如柱坐标，
用户定义坐标等）用于设定几何项目

在空间的位置.  

Main Menu: Modeling > Create > 

Keypoints > In Active CS ...

激活坐标系统可以与工作平面重合，也可以是总体坐标（或局部坐标）系统。这个话题将在后面的课程
中详细描述.



实体建模 - 由上而下建模

…布尔运算

• 布尔运算 是对几何实体进行合并的计算。ANSYS 中布尔运算包括
加、减、相交、叠分、粘接、搭接.

• 布尔运算时输入的可以是任意几何实体从简单的图元到通过CAD输
入的复杂的几何体。

加

输入实体 布尔运算 输出实体



实体建模 - 由上而下建模

…布尔运算

• 所有的布尔运算可以在GUI界面下获得 Preprocessor > -Modeling-

Operate.

• 在缺省状态下, 布尔运算时输入的几何实体在运算结束后将删除.

• 被删除实体的编号数被“释放” (即, 这些编号可以可以指定给新的
实体，并从可以获得的最小编号开始）。



实体建模 - 由上而下建模

…布尔运算

• 加

– 把两个或多个实体合并为一个.



实体建模 - 由上而下建模

…布尔运算

• 粘接

– 把两个或多个实体粘合到一起，在其接触面上具有共同的边界

– 当你想定义两个不同的实体时特别方便（如对不同材料组成的实体）



实体建模 - 由上而下建模

…布尔运算

• 搭接

– 类似于粘合运算，但输入的实体有重叠.



实体建模 - 由上而下建模

…布尔运算

• 减

– 删除“母体”中一块或多块与子体重合的部分。

– 对于建立带孔的实体或准确切除部分实体特别方便.



实体建模 - 由上而下建模

…布尔运算

• 叠分

– 把一个实体分割为两个或多个，它们仍通过共同的边界连接在一起.

– “切割工具” 可以是工作平面、面线甚至于体.

– 在用块体划分网格时，通过对实体的分割，可以把复杂的实体变为简
单的体.



实体建模 - 由上而下建模

…布尔运算

• 相交

– 只保留两个或多个实体重叠的部分.

– 如果输入了多于两个的实体,则有两种选择: 公共相交和两两相交

• 公共相交只保留全部实体的共同部分.

• 两两相交则保留每一对实体的共同部分，这样，有可能输出多个实
体.

Common

Intersection

Pairwise

Intersection



实体建模 - 由上而下建模

…布尔运算

• 互分

– 把两个或多个实体分为多个实体，但相互之间仍通过共同的边界连接
在一起。

– 若想找到两条相交线的交点并保留这些线时，此命令特别有用，如下
图所示.  (交运算可以找到交点但删除了两条线）

L1

L2

L3

L6

L5
L4

Partition



实体建模

D.  由下而上建模

• 由下向上建模时首先建立关键点，从关键点开始建立其它实体。

• 如建立一个L-形时, 可以先下面所示的角点. 然后通过连接点简单地
形成面，或者先形成线，然后用线定义面.



实体建模 - 由下而上建模

关键点

• 定义关键点:

– Preprocessor > -Modeling- Create > 

Keypoints

– 或者用 K 命令组立的命令:  K, KFILL, 

KNODE, 等.

• 生成关键点时只需要关键点的编号及点的坐标值数据.

– 关键点编号的缺省值为下一个整数

– 坐标位置可以通过在工作平面上拾取或输入X,Y,Z 坐标值确定.坐标值
如何确定？它依赖于当前激活坐标系.



实体建模 - 由下而上建模

坐标系

激活坐标系

• 缺省时是总体直角坐标系.

• 用CSYS命令 (或Utility Menu > 

WorkPlane > Change Active CS to) 

可将其改变为

– 总体直角坐标系 [csys,0]

– 总体柱坐标系[csys,1]

– 总体球坐标系[csys,2]

– 工作平面 [csys,4]

– 或用户定义的局部坐标系 [csys, n]

这些坐标系将在下面介绍。



实体建模 - 由下而上建模

...坐标系

总体坐标系

• 模型的总体参考系.

• 可以是直角坐标系（0）、柱坐标系（1）或球坐标系 (2).

– 例如, 总体直角坐标系中的点 (0,10,0)与总体柱坐标系中的点 (10,90,0)

是同一个点.



实体建模 - 由下而上建模

...坐标系

局部坐标系

• 用户在期望的位置定义的坐标系, 其ID编号大于或等
于11.  位置可以在:

– 工作平面原点 [CSWP]

– 位于特定的坐标位置[LOCAL]

– 位于已经存在的关键点 [CSKP]或节点 [CS]

• 可以是直角坐标系、柱坐标系或球坐标系.

• 可以绕X、Y、Z轴旋转.

X

Y

X11

Y11

X12

Y12



实体建模 - 由下而上建模

…坐标系

工作平面坐标系

• 依附于工作平面上.

• 主要用来确定实体图元的位置及方向.

• 也可以通过在工作平面上拾取来定义关键点.



实体建模 - 由下而上建模

...坐标系

• 可以定义多个坐标系，但任何时候只
能有一个坐标系被激活.

• 有些几何实体受定义时激活坐标系的
影响 [CSYS]:

– 关键点和节点位置

– 线的曲率

– 面的曲率

– 生成或填充的关键点和节点

– 等等.

• 图形窗口标题显示了活动坐标系.



实体建模 - 由下而上建模

线

• 有许多方法定义线，如：

• 如果定义面或体, ANSYS 将自动生成未定义的线，线的曲率由当
前激活坐标系确定.

• 在生成线时，关键点必须存在。

Create >

-Lines- Arcs

Create >

-Lines- Lines

Create >

-Lines- Splines

Operate >

Extrude / Sweep



实体建模 - 由下而上建模

面

• 用由下向上的方法生成面时，需要的关键点或线必须已经定义

• 如果定义体，ANSYS 将自动生成未定义的面、线，线的曲率由当
前激活坐标系确定.

Create >

-Areas- Arbitrary

Operate > Extrude



实体建模 - 由下而上建模

体

• 用由下向上的方法生成体时，需要的关键点或线或面必须已经定义

Create >

-Volumes- Arbitrary

Operate > Extrude



实体建模 - 由下而上建模

操作

• 在由上而下和由下而上的建模方式均可对实体进行布尔运算.

• 除了布尔运算，还有许多其它操作命令:

– 拖拉

– 缩放

– 移动

– 拷贝

– 反射

– 合并

– 倒角



实体建模 - 由下而上建模

...操作

拖拉

• 利用已经存在的面快速生成体 (或由线生成面或由关键
点生成线).

• 如果面已经划分了网格，单元也可以随着面一起拖拉

• 有四种方法拖拉面:

– 法向拖拉— 通过对面的法向偏移形成体 [VOFFST] .

– XYZ偏移 —通过对面的总体XYZ方向偏移形成体 [VEXT].  

可以锥形拖拉

– 沿坐标轴 — 绕坐标轴旋转面形成体(也可通过两个关键点
旋转) [VROTAT].

– 沿直线—沿一条线或一组邻近的线拖拉面形成体
[VDRAG].



实体建模 - 由下而上建模

...操作

缩放

• 从一种单位系统转到另一种单位系统时特别方便.

• 在第4章讨论.



实体建模 - 由下而上建模

...操作

移动

• 通过增量DX,DY,DZ控制实体的移动或旋
转.

– DX,DY,DZ定义在激活坐标系中

– 平移实体时，令激活坐标系为直角坐标系

– 转动实体时，令激活坐标系为柱或球坐标
系

– 可以使用下列命令VGEN, AGEN, LGEN, 

KGEN

• 另一个选项是把坐标转换到另一个坐标
系中.

– 转换发生在激活坐标系与指定的坐标系之
间. 

– 此命令在对一个实体的移动和旋转同时进
行时很有用.

– 可使用下列命令

• VTRAN, ATRAN, LTRAN, KTRAN

从 csys,0 

向 csys,11 

转换

旋转 -

30°



实体建模 - 由下而上建模

...操作

拷贝

• 生成实体的多个拷贝

• 通过复制的份数（2及其以上）及增量
DX,DY,DZ 控制.  DX,DY,DZ定义在激
活坐标系中.

• 对于生成多个孔、翼等特别有用.

Copy in

local

cylindrical

CS

Create outer

areas by

skinning



实体建模 - 由下而上建模

...操作

反射

• 沿平面反射实体.

• 修改反射方向:

– X 关于YZ平面反射

– Y关于XZ平面反射

– Z关于XY平面反射

所有的方向均定义在激活坐标系，且必
须是直角坐标系.

What is the direction of 

reflection in this case?



实体建模 - 由下而上建模

...操作

合并

• 把两个实体合并，并删除重合的关键点.

– 合并关键点时，如果存在高一层次重合的实体，也将自动被合并.

• 通常在反射、复制或其它操作后产生重合的实体时需要合并.

Merge or glue

required

Reflect



Subtract from

base area

实体建模 - 由下而上建模

...操作

倒角

• 线的倒角连接需要两条相交的线，且在相交处有
共同的关键点.

– 如果共同的关键点不存在，则首先作互分的运算.

– ANSYS不改变依附的面（如果有），因此，需要
用加或减的命令修改倒角区域.

• 面的倒角与此相似
Create

fillet

Create

area
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单元属性

单元属性是指在划分网格以前必须指定的所分析对
象的特征.  这些特征包括:

• 材料属性

• 单元类型

• 实常数

Definition



材料属性

ANSYS所有的分析都需要输入材料属性- 例如在结构
分析至少要输入材料的杨氏模量EXX，热分析至少要
输入材料的导热系数等KXX.  

Objective

3-14. 定义材料属性、单元类型以及实常数.



材料属性（续）

下表是ANSYS全部的材料属性.



定义材料属性

要定义材料属性 :

Main Menu>Preprocessor>Material Props>Material Models

Procedure

1. .....

2. .....

3. .....

例如:  定义恒定的各向同性材料属性

1. 选择要定义的材料属性类别

2. 在相应的框中输入材料属性值 (如
果需要可使用滚动条).

3.  选择 OK.材料模型的编号依次自动
增加.



ANSYS分析中的单位制

• 除了磁场分析以外，用户不需要告诉ANSYS使用的是什么单位制.  只需
要自己决定使用何种单位制，然后确保所有输入的值的单位制保持统一
(ANSYS并不转换单位制).  ANSYS读入输入的数值，并不检验单位制是
否正确. [注意: /UNITS 命令只是一种简单的记录，告诉别的人现在使用
的单位制.]

• 单位制将影响输入的实体模型尺寸、材料属性、实常数以及载荷等.



定义单元类型

设定单元类型:

Main Menu:  Preprocessor > Element Type > 

Add/Edit/Delete
Procedure

1. .....

2. .....

3. .....

1.  选择 Add.



定义单元类型 (续)

2.  选择 Help 得到关于单元
类型的信息.

3.  选择单元图示摘要.



定义单元类型(续)

5.  使用图示摘要可
以帮助选择单元
类型.  如果需要
某种单元的详细
描述，点取单元
图形即可.当选
定了单元类型后
，记住名称和代
号，选择
choose File > 

Exit退出.



定义单元类型(续)

7.  选择单元类型.

6.  选择单元分类.

8.  选择 OK.



定义单元类型(续)

9.  如果必要，选择 Options 修改单元选项.  

以下是PLANE82的单元选项设置.

10.  选择 Close 结束单元类型定义.

选择 Help 得到更多单元选
项的帮助. 



ANSYS “实常数”

实常数是针对某一单元的几何特征, 例如:

• 梁单元的横截面积.

• 壳单元的厚度.

分析用中到的单元的实常数，可以查阅单元在线帮助. 注意并不
是所有的单元都需要实常数.

Definition



定义实常数

选择了单元类型后，定义单元实常数:

Main Menu:  Preprocessor > Real Constants

Procedure

1. .....

2. .....

3. .....

1.  选择 Add.

2.  选择要定义的实

常数是针对哪种
单元类型.

3.  选择 OK.



定义实常数 (续)

5.  选择 e OK.

4.  输入实常数.

6.  如果要定义另一实常
数，选择 Add 并重
复2～5步.

7. 结束实常数定义，选
择 Close.



5. 梁

• 梁单元 是线单元，是3-D结构的一维理想化模型

• 梁单元比实体和壳单元更有效，尤其常用于下列工业领域中:

– 建筑结构

– 桥梁和道路

– 公共交通 (有轨电车,

火车, 公共汽车)

– 等



...梁

• 本节将通过如下的主题对梁做简要介绍:

A. 梁的属性

B.  梁网格划分

C.  加载,求解, 结果

D.  专题



梁

A. 梁的属性

• 建立梁的第一步，同任何分析一样，先建立几何模型 — 通常是由
关键点和线组成的框架结构。

• 然后定义如下的梁的属性:

– 单元类型

– 横截面

– 材料特性



梁

...梁的属性

单元类型

• 选择下面类型中的一个:

– BEAM188 — 3-D, 线性 (2-node)

– BEAM189 — 3-D, 二次函数 (3-node)

• ANSYS 有许多其它梁单元，但推荐使用 BEAM188 和 189

– 对绝大部分梁结构都适合

– 支持线性和非线性分析,包括塑性，大变形和非线性失稳

– 具有包括用多种材料模拟层状材料，复合材料，截面加强的能力

– 具有用户定义截面几何尺寸的能力

– 在前、后处理过程中容易使用



梁

...梁属性

横截面

• 对 BEAM188 和 189单元的完整定义包括对横
截面属性的定义。

• BeamTool提供了方便的操作.

– Preprocessor > Sections > Common Sectns...

– 选择想要的形状，然后输入尺寸

– 按 Preview 按钮观看形状,然后按 OK.

– 若有多个横截面，必须给每个横截面指定编号
（任意定义名称）



梁

...梁属性

• 1-1梁横截面的样本预览如下 (SECPLOT) 

• 除了预先定义好的横截面形状之外， ANSYS允许用户通过建立二维实体
模型来建立自己的“自定义”横截面形状

• 同标准横截面一样，可以把自定
义的横截面和想要的尺寸保存到
横截面库中以便日后使用。

• 参阅ANSYS 结构分析手册第15

章获取详细信息



梁

...梁属性

材料属性

• 线性和非线性材料属性均可

• 所有梁的属性定义好以后，下一步是对几何模型进行网格划分



梁

B.  梁网格划分

• 用梁单元对几何模型做网格划分包括三个主要步骤:

– 指定线的属性

– 指定线分割

– 划分网格

• MeshTool 提供了上述三个步骤的便利操作



梁

...梁网格划分

步骤1: 线属性

• 梁网格划分的线属性包括:

– 材料号

– 横截面号

– 方向关键点

• 相对于梁轴线，横截面是怎样放置

• 所有横截面类型都需要指定

• 单个关键点可以分配给多条线 ( 即不需要为每条线指定独立关键点)

• 每条线的端点都有它的方向关键点，允许横截面绕梁轴线扭转。



梁单元

...梁网格划分

• 使用方向关键点的例子:



梁

...梁网格划分

• 使用Mesh Tool的单元属性指定线属性 (或选择想要的线和使用
LATT 命令)

拾取线

BEAM188 & 189

单元的附加属性



梁

...梁网格划分

步骤2 :线分割

• 对 BEAM188 和 189 单元，建议不要把整个梁当作一个单元

• 使用 Mesh Tool的 “Size Controls”指定想要的线分割数
(或用 LESIZE 命令).



梁

...梁网格划分

步骤3:生成网格

• 先保存数据库文件 (Toolbar > SAVE_DB 或使用SAVE 命令).

• 按下Mesh Tool中的 Mesh 按钮 (或执行 LMESH,ALL命令) 生成网
格

拾取线



梁

...梁网格划分

• 在单元绘图中显示横截面形状,  激活显示单元形状:

– Utility Menu > PlotCtrls > Style > Size and Shape…

– 或使用命令 /ESHAPE,1



梁

...梁网格划分

• 网格划分完成后,接着施加荷载并求解



梁

C.  加载, 求解， 结果

• 梁的典型加载包括:

– 位移约束

• 施加在节点或关键点上

– 力

• 施加在节点或关键点上

– 压力

• 施加在单位长度上

• 施加在单元表面上

• Solution > Apply > Pressures > On Beams

– 或 使用SFBEAM 命令

– 重力或旋转速度

• 作用在整个结构上



梁

... 加载, 求解，结果

• 获取解答:

– 先保存数据库文件.

– 求解.  (或把载荷写入载荷步文件，然后求解所有载荷步)

• 查看结果的方法同应力分析相同:

– 观察变形

– 观察反力

– 画应力、应变图

• BEAM188 和 189 单元的主要优势是应力可以直接在单元上观看
（同壳和实体单元），必须激活单元形状显示。



梁

... 加载, 求解，结果

• 演示:

– 恢复数据库文件(包括线，关键点，载荷，单元类型, 材料和两个横截面)

– 画出两个已定义的横截面 (SECPLOT,1 & 2)

– 用 BeamTool 定义第三个横截面:

• ID=3:  Name = peak, Sub-type = box (空心矩形), W1=6, W2=6; T1=T2=T3=T4=0.25

– 打开 MeshTool, GPLOT, 对下面的线属性赋值:

• 斜线: mat=1, secnum=3, 定位关键点 KP =100

• 左垂线 : mat=1, secnum=2, 定位关键点 KP =102

• 右垂线 : mat=1, secnum=2,定位关键点 KP = 101

• 左前平行线: mat=1, secnum=1, 定位关键点 KP = 1

• 右后平行线: mat=1, secnum=1, 定位关键点 KP = 3

– 指定所有线 size=20

– 存储，接着使用命令LMESH,ALL; 命令EPLOT 和命令 /ESHAPE,1

– 对关键点9施加fy方向的大小为-10000lb的载荷，约束4个底部关键点的所有自由度

– 求解, 接着观察结果：变形图，反力，应力SX (= 轴向 +弯曲).选择横截面编号是3的单元，
再画应力图。对2号横截面重复上面的操作。



梁

D. 专题

梁单元练习

beam.ppt
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有限元模型生成--网格划分

概述

• 网格划分包含以下3个步骤 :

– 定义单元属性

– 指定网格的控制参数

– 生成网格

• 本章, 我们将详细介绍上述3个步骤并讨论网格划分的其他选项.

• 内容包括:

A.  多种单元属性 E.  过渡网格划分

B.  控制网格密度 F.  网格的拖拉

C.  改变网格 G.  扫掠网格划分

D.  映射网格划分 H.  实践



网格划分

A.  多种单元属性

• 如前所述, 每个单元有以下与之相关的属性:

– 单元类型 (TYPE)

– 实常数 (REAL)

– 材料特性 (MAT)

• 许多 FEA 模型有多种属性.  例如，下图所示的筒仓有两种单元类型, 三种
实常数, 以及两种材料.

材料 1 = 混凝土
材料 2 = 钢

实常数 1 = 3/8” 厚度
实常数 2 = 梁单元特性
实常数 3 = 1/8” 厚度

类型 1 = 壳单元
类型 2 = 梁单元



网格划分

...多种单元属性

• 只要模型中有多种单元类型(TYPEs), 实常数(REALs) 和 材料
(MATs), 就必须确保给每一种单元指定了合适的属性.  有以下3种
途径:

– 在网格划分前为实体模型指定属性

– 在网格划分前对MAT, TYPE,和REAL进行 “总体的” 设置

– 在网格划分后修改单元属性

• 如果没有为单元指定属性, ANSYS将MAT=1, TYPE=1, 和 REAL=1

作为模型中所有单元的缺省设置. 注意, 采用当前激活的TYPE, 

REAL, 和 MAT 进行网格操作.
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...多种单元属性

为实体模型指定属性

1. 定义所有需要的单元类型,材料, 和实常数.

2. 然后使用 网格工具的“单元属性” 菜单条
(Preprocessor > MeshTool):

– 选择实体类型后按 SET键.

– 拾取您想要指定属性的实体.

– 在后续的对话框设置适当的属性.

或 选择需要的实体,使用 VATT, AATT, LATT, 或
KATT 命令.

3. 当您为实体划分网格时, 它的属性将自动转换到单
元上.
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...多种单元属性

使用总体的属性设置

1. 定义所有需要的单元类型,材料, 和实常数.

2. 然后使用网格工具的“单元属性” 菜单条
(Preprocessor > MeshTool):

– 选择 Global 后按 SET 键.

– 在 “网格划分属性” 对话框中激活需要的属
性组合.  这些被视为激活的 TYPE, REAL,和
MAT 设置.

或使用 TYPE, REAL, 和 MAT 命令.

3. 仅对使用上述设置属性的实体划分网格.
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...多种单元属性

修改单元属性

1. 定义所有需要的单元类型,材料, 和实常数.

2. 激活需要的TYPE, REAL, 和 MAT设置的组合:

– Main Menu>Preprocessor>-Modeling-Create>Elements>Elem Attributes

– 或使用 TYPE, REAL, 和 MAT 命令

3. 仅修改使用上述设置属性的单元的属性:

– 使用 EMODIF,PICK 命令或选择 Menu>Preprocessor>Modeling>Move / 

Modify>Elements>Modify Attrib

– 拾取需要的单元

4. 在后续的对话框,将属性设置为
“All to current.”
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...多种单元属性

牢记以下几点:

• 您可以激活属性编号校核单元属性 :

– Utility Menu > PlotCtrls > Numbering

– 或用 /PNUM,attr,ON命令, attr 可以是 TYPE, 
MAT, 或 REAL

• 在实体模型上直接指定属性将不考虑缺省属性. 

• 在实体模型上指定属性, 您可以避免在网格划分操作中重新设置属性. 由于
ANSYS 的网格划分算法在一次对所有实体进行网格划分时更为有效,因而
这种方法更为优越.

• 清除实体模型上的网格将不会删除指定的单元属性.
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B.  控制网格密度

• ANSYS 提供了多种控制网格密度的工具, 既可以是总体控制也可
以是局部控制:

– 总体控制

• 智能网格划分

• 总体单元尺寸

• 缺省尺寸

– 局部控制

• 关键点尺寸

• 线尺寸

• 面尺寸
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...控制网格密度

智能网格划分

• 通过指定所有线上的份数决定单元的尺寸, 它可以考虑线的曲率, 孔
洞的接近程度和其它特征, 以及单元阶次.

• 智能网格划分的缺省设置是关闭, 在自由网格划分时建议采用智能
网格划分。 它对映射网格划分没有影响.  (自由网格划分与映射网
格划分将在后面讨论.)
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...控制网格密度

• 使用智能网格划分:

– 导出MeshTool菜单条 (Preprocessor > MeshTool), 打开
智能网格划分, 设置需要的尺寸级别.

• 或使用 SMRT,level 命令

• 尺寸级别的范围从 1 (精细) 到10 (粗糙).  缺省级别为
6.

– 对所有体 (或所有面)一次划分网格, 将优越于一个一个地

划分网格.



网格划分

...控制网格密度

• 如图所示为采用不同的SmartSize

尺寸级别进行四面体网格划分的例
子.

• 高级的 SmartSize 控制, 如网格扩
张和过渡系数在SMRTSIZE 命令 (

或Preprocessor > -Meshing- Size 

Cntrls > -SmartSize- Adv Opts...)中
提供.

• 您可以使用MeshTool菜单条或采
用smrt,off命令关闭智能网格划分.
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...控制网格密度

总体单元尺寸

• 您可以为整个模型指定最大的单元边长 (或每条线的份数):

– ESIZE,SIZE

– 或 Preprocessor > MeshTool > “Size Controls - Global” [Set]

– 或 Main Menu>Preprocessor>Meshing>Size 

Cntrls>ManualSize>Global>Size

– 或 Main Menu>Preprocessor>Meshing>Size 

Cntrls>SmartSize>Adv Opts

• 可单独使用或与 智能网格划分联合使用.

– 单独使用ESIZE (智能网格划分关闭) 将采用相
同的单元尺寸对体 (或面) 划分网格.

– 在 智能网格划分 打开时, ESIZE 充当 “向导
,” 但为了适应线的曲率或几何近似指定的尺寸
可能无效.
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...控制网格密度

缺省尺寸

• 如果您不指定任何控制, ANSYS 将使用缺省尺寸, 它将根据单元阶
次指定线的最小和最大份数, 表面高宽比等. 

• 用于映射网格划分, 但在智能网格划分关闭时, 自由网格划分也可使
用.

• 您可以采用 DESIZE 命令或 Main Menu > Preprocessor > 

Meshing > Size Cntrls > ManualSize > Global > Other 调节缺省的
尺寸规格.
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...控制网格密度

关键点尺寸

• 通过关键点控制单元尺寸:

– Preprocessor > MeshTool > “Size Controls: Keypt” [Set]

– 或 KESIZE 命令

– 或 Preprocessor >Meshing >Size Cntrls >ManualSize 

>Keypoints >Picked KPs 

不同的关键点可以不同的 KESIZE, 为您在网格上有更
多的控制.

• 对应力集中区域非常有用.

• 智能网格划分打开时,为了适应线的曲率或几何近似指
定的尺寸可能无效.
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...控制网格密度

线尺寸

• 控制线上单元尺寸:

– Preprocessor > MeshTool > Size Controls: Lines 

[Set]

– 或 LESIZE 命令

– 或 Preprocessor > -Meshing- Size Cntrls > -Lines-

不同的线可以有不同的 LESIZE.

• 指定尺寸可以是 “硬的” 或 “软的.”

– “硬的”尺寸即使在智能网格划分打开时也将被网
格划分器采用.  在所有其它尺寸控制最优先.

– “软的”尺寸在智能网格划分打开时可能无效.

• 您也可以指定一个边长比例 — 最后一个分割与第
一个分割的比率. 使网格偏向线的一端或中间.  

对 “软的”
选是
对 “硬的”
选否
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...控制网格密度

面尺寸

• 在面的内部控制单元尺寸:

– Preprocessor > MeshTool > “Size Controls: Areas” [Set]

– 或 AESIZE 命令

– 或 Preprocessor > -Meshing- Size Cntrls > -Areas-

不同的面可以有不同的AESIZE.

• 面与面的交线仅在未指定LESIZE 或 KESIZE 且邻近无尺
寸更小的面时使用指定尺寸.

• 智能网格划分打开时,为了适应线的曲率或几何近似 指定
的尺寸可能无效.
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...控制网格密度

• 演示:

– 恢复 ribgeom.db

– 用 SMRT,6 划分网格.  (并非很好的网格)

– 用 SMRT,3 重新划分网格(好的网格)

– 将ESIZE设为0.2后重新划分网格. 由于智能网格划分器考虑了 ESIZE ,

即使SMRT设为 3, 网格也变得很粗糙.  同时注意单元尺寸并不相同 (因
为 SMRT 为打开状态).

– 关闭 SMRT重新划分网格. 单元尺寸现在完全相同.
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C.  改变网格

• 如果划分的网格不满意, 您总可以通过以下步骤重
新划分网格:

1. 清除网格.

• clear 操作网格划分的逆操作 : 它将 删除 节点和
单元.

• 使用在 MeshTool中得 [Clear] 按钮, 或使用
VCLEAR, ACLEAR, 等.

(若您在使用 MeshTool, 您可以跳过这一步,因为程序
将在执行第3步时提示您是否清除网格)

2. 指定新的或不同的网格控制.

3. 再次划分网格.
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...改变网格

• 另一个网格划分选项是在指定的区域
refine (细化)网格.

– 对所有的面单元和四面体体单元有效.

– 简易的方法是使用 MeshTool:

• 存储数据库.

• 选择您想要细化的区域 — 在节点, 单
元, 关键点, 线, 或面 — 按 Refine 键.

• 拾取您想要细化的实体.  (若选择
“All Elems 不必执行此操作.”)

• 选择细化的尺寸级别.  级别 1 (最小
细化) 是一个好的起点.
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D.  映射网格划分

• 有两种主要的网格划分方法:  自由划分和映射划分.

• 自由划分

– 无单元形状限制.

– 网格无固定的模式.

– 适用于复杂形状的面和体.

• 映射划分

– 面的单元形状限制为四边形,体的单元限制为六面体 (

方块).

– 通常有规则的形式,单元明显成行.

– 仅适用于 “规则的” 面和体, 如 矩形和方块.
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...映射网格划分

自由网格

+ 易于生成; 不须将复杂形状的体分
解为规则形状的体.

– 体单元仅包含四面体网格, 致使单
元数量较多.

– 仅高阶 (10-节点) 四面体单元较满
意, 因此DOF(自由度)数目可能很
多.

映射网格

+ 通常包含较少的单元数量.

+ 低阶单元也可能得到满意的结果,

因此DOF(自由度)数目较少.

– 面和体必须形状 “规则”, 划分
的网格必须满足一定的准则.

– 难于实现, 尤其是对形状复杂的体
.
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...映射网格划分

生成自由网格

• 自由网格是面和体网格划分时的缺省设置.

• 生成自由网格比较容易:

– 导出 MeshTool 工具, 划分方式设为自由划分.

– 推荐使用智能网格划分 进行自由网格划分, 激活它并
指定一个尺寸级别.  存储数据库.

– 按 Mesh 按钮开始划分网格.

• 按拾取器中 [Pick All] 选择所有实体 (推荐).

– 或使用命令 VMESH,ALL 或 AMESH,ALL.
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...映射网格划分

生成映射网格

• 由于面和体必须满足一定的要求,生成映射网格不如生成自由网格
容易 :

– 面必须包含 3 或 4 条线 (三角形或四边形).

– 体必须包含4, 5, 或 6 个面 (四面体, 三棱柱, 或六面体).

– 对边的单元分割必须匹配.

• 对三角形面或四面体, 单元分割数必须为偶数.
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...映射网格划分

• 对四边形面或六面体, 允许采用不等的分割, 如下面的例子所示, 但
分割数必须满足一个关系式 (见下页).
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...映射网格划分
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...映射网格划分

• 因此 ,映射网格划分包含以下三个步骤:

– 保证 “规则的”形状, 即, 面有 3 或4 条边, 或 体有 4, 5, 或 6 个面.

– 指定尺寸和形状控制

– 生成网格
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...映射网格划分

保证规则的形状

• 在许多情况下, 模型的几何形状上有多于4条边的面,有多于6个面的
体.  为了将它们转换成规则的形状, 您可能进行如下的一项或两项
操作:

– 把面 (或体) 切割成小的, 简单的形状.

– 连接两条或多条线 (或面) 以减少总的边数.
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...映射网格划分

• 切割 可以通过布尔减运算实现.

– 您可以使用工作平面, 一个面, 或一条线 作为切割工具.

– 有时, 生成一条新的线或面会比移动或定向工作平面到正确的方向容易
得多.
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...映射网格划分

• 连接 操作是生成一条新线 (为网格划分) , 它通过连接两条或多条线
以减少构成面的线数.

– 使用 LCCAT 命令或 Preprocessor > -Meshing- Concatenate > Lines, 

然后拾取须连接的线.

– 对面进行连接, 使用 ACCAT 命令或Preprocessor > -Meshing-

Concatenate > Areas

连接这两条线
使其成为一个
由4条边构成
的面
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...映射网格划分

• 您也可以简单地通过一个面上的3个或4个角点 暗示 一
个连接.  此时, ANSYS 内在地 生成一个连接.

– 在MeshTool中选择Quad shape 和 Map 网格.

– 将 3/4 sided 变为 Pick corners.

– 按 Mesh 键, 拾取面, 然后拾取 3 或 4 角点形成一规则的
形状.
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...映射网格划分

• 使用连接时注意:

– 它仅仅是一个网格划分操作,因而应为网格划分前的最后一步, 在所有的实体建
模之后.  这是因为，经连接操作得到的实体不能在后续的实体建模操作中使用.

– 可以通过删除产生的线或面 “undo(取消)” 一个连接.

– 连接面 (为在体上映射网格) 通常比较复杂,因为您也应该连接一些线. 只有在对
相邻的两个4边形面作连接时其中的线会自动连接.

– 若两条线或两个面 相切交汇可考虑用加 (布尔) 运算.
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...映射网格划分

指定尺寸和形状控制

• 这是映射网格划分3个步骤中的第2步.

• 选择单元形状非常简单.  在 MeshTool中,对面的网格划
分选择 Quad,对体的网格划分选择 Hex, 点击 Map.

• 其中通常采用的尺寸控制和级别如下:

– 线尺寸 [LESIZE] 级别较高.

– 若指定了总体单元尺寸, 它将用于 “未给定尺寸的” 线.

– 缺省的单元尺寸 [DESIZE]仅在未指定ESIZE时用于 “未给
定尺寸的” 线上.

– (智能网格划分 无效.)
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...映射网格划分

• 若您指定线的分割数, 切记:

– 对边的分割数必须匹配, 但您只须指定一边的分割数.  映射网格划分器
将把分割数自动传送到它的对边.

– 如果模型中有连接线, 只能在原始(输入)线上指定分割数,而不能在合成
线上指定分割数.

每条初始线上指定6份分割.

此线上将自动使用12 份分
割 (合成线的对边).

其它两条线上会采用几份分
割 呢?  (后面的演示将会回
答这一问题.)
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...映射网格划分

生成映射网格

• 只要保证了规则的形状 并指定了合适的份数, 生成网格将非常简单.  

只须按MeshTool中的 Mesh 键, 然后按拾取器中的 [Pick All] 或选
择需要的实体即可.
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...映射网格划分

• 问题: 为划分映射网格您将
如何切割这个模型?

• 答案: 不值得费力!
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E.  过渡网格划分

• 对体划分网格, 至今我们已见了两种选择:

– 自由网格划分, 生成一个 全四面体 网格.  这很容
易实现但在某些情况下并不令人满意,.

– 映射网格划分, 生成一个 全六面体 网格.  这一方
法令人满意但通常很难实现.

• Hex-to-tet meshing 提供了第三种选择,它 “集
两家之长.” 将四面体和六面体网格很好地结合
起来 而不破坏网格的整体性.
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...过渡网格划分

• 这一选择是在六面体单元和四面体单元间的过渡区生成金字塔形单元，要
求：

– 必须有六面体网格 (至少在交界面上有四边形网格).

– 网格划分器首先生成四面体单元, 然后通过组合或重新组织过渡区的四面体单
元形成金字塔形单元.

– 仅适用于既支持金字塔形又支持四面体形状的单元类型, 例如:

• 结构单元 SOLID95, 186, VISCO89

• 热单元 SOLID90

• 多物理场单元 SOLID62, 117, 122

SOLID95 

– 即使在过渡区结果也会很好. 即使是从线性
六面体单元向二次四面体单元过渡,单元表
面都是协调的.
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...过渡网格划分

– 过渡网格对 二次-到-二次 和 线性-到-二次的过渡都是有效的. 后者的单元类型
必须支持 9-节点金字塔单元.

8-节点六面体 9-节点金字塔 10-节点四面体

六面体网格 过渡网格 四面体网格

二次
到

二次

线性
到

二次

10-节点四面体13-节点金字塔20-节点六面体
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...过渡网格划分

过程包括四个步骤 :

1. 生成六面体单元.

– 由对规则形状体划分映射网格开始.  (或对交界面划分四边形网格.)

– 对于应力分析, 既可采用 8-节点块体单元 (SOLID45 或 SOLID185) 也
可用 20-节点块体单元(SOLID95 或 SOLID186).
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...过渡网格划分

2. 激活既支持金字塔单元又支持四面体单元的单元类型.

– 这些单元类型的块体单元通常可退化为金字塔单元或四面体单元.  检
查在线的 单元手册, 查看哪些单元类型有效.

– 例如:

• 结构单元 SOLID95, 186, VISCO89

• 热单元 SOLID90

• 多物理场单元 SOLID62, 117, 122
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...过渡网格划分

3. 生成四面体单元.

– 首先激活自由网格划分.

– 然后划分那些要生成四面体单元的体.

在分界面上会自动生成金字塔单元.
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...过渡网格划分

4. 将退化的四面体单元转换成真实的10-节点四面体单元.

– 由转换网格生成器生成的四面体网格由 退化 单元组成 — 如从20-节点
块体单元导出的10-节点四面体单元.

– 这些单元不如真实的10-节点四面体单元(如 SOLID92)有效, 它求解过
程中使用较少的内存,写较小的文件.

– 为了将退化的四面体单元转换成真实的四面体单元,采用:

• Preprocessor > -Meshing- Modify Mesh > Change Tets...

• 或使用 TCHG 命令.



网格划分

F.  网格拖拉

• 当把一个面拖拉成一个体时, 您可以将面上的网格随同它一起拖拉, 
得到一个已网格化的体.  这称为 网格拖拉.

• 优点:易于生成带有块体单元(六面体)或块体单元和棱柱体单元组合
的体网格.

• 必要条件:  体的形状必须允许它拖拉.

拖拉



网格划分

...网格拖拉

步骤

1. 定义两种单元类型 — 一种面单元和一种
体单元.

– 面单元: 选择 MESH200 四边形单元.  
MESH200 是一种 仅划分网格 (不求解)
的单元没有与之相关的自由度或材料特
性

– 体单元: 应与 MESH200 单元类型匹配.  
例如, 若您选择的 MESH200单元有中间
节点, 那么3-D 实体单元也应有中间节点.

– ET 命令或 Preprocessor > Element 
Type > Add/Edit/Delete



网格划分

...网格拖拉

2. 用MESH200单元划分需拖拉的面.

– 使用需要的映射划分或自由划分网格密度.

– Preprocessor > MeshTool

3. 选定单元拖拉选项.

– EXTOPT 命令或 Preprocessor > Operate > 

Extrude > Elem Ext Opts

– 典型的选项是:

• 激活 TYPE 属性 (应为 3-D 实体).

• 在拖拉方向单元的份数 (即,厚度方向的单
元数).  必须大于零; 否则, 仅拖拉面,而不
拖拉网格.



网格划分

...网格拖拉

4. 拖拉面.

– 若有连接线,先删除它.  如果存在连接, ANSYS 将不允许进行拖拉操作.

• Preprocessor > -Meshing- Concatenate > -Del Concats- Lines

– 然后利用任一种拖拉方法拖拉面.



网格划分

G.  扫掠划分

• 扫掠划分 是另一种为体划分网格的选择.  它是一个通过扫掠面上的
网格从而为一个已有的体划分网格的过程.

• 与网格拖拉相似, 只是在这一情况下体必须是存在的 (如通过几何体
的输入).



网格划分

...扫掠划分

• 优点:

– 易于生成带有块体单元(六面体)或块体单
元和棱柱体单元组合的体网格.

– 对体进行四面体网格划分时,选项设置是 “
不可扫掠的.” 自动生成过渡金字塔网格.

• 必要条件:

– 体在扫掠方向的拓扑结构必须一致.  例如:  

穿孔的块体 (即使孔洞是锥体).

– 源 面和目标 面 必须是 单个 面.  而不允许
是连接面.

源面
(1 个面)

目标面
(1 个面)

扫掠划分有效

不能做扫掠划分



网格划分

...扫掠划分

步骤

• 定义并激活一个 3-D 六面体 实体单元类型, 如结构单元
SOLID45 或 SOLID95.

• 进入 MeshTool 选择 Hex/Wedge 和 Sweep.

• 选择如何识别 源面和目标面 :

– “Auto Source/Target”选项 意味着 ANSYS 会根据体的
拓扑结构自动选择它们.

– “Pick Source/Target”选项意味着您要选择它们.

• 按 SWEEP 键,遵照拾取器后续的提示指令完成划分.  (

或使用 VSWEEP 命令.)



网格划分

...扫掠划分

四面体网格划分选项

• 在不可采用扫掠划分的体中生成四面体网格
是一个十分有用的扫掠选项.

• 为使用此选项:

– 确信单元类型 支持退化的金字塔和四面体形
单元 ,如:

• 结构单元 SOLID95, 186, VISCO89

• 热单元 SOLID90

• 多物理场单元 SOLID62, 117, 122

– 选择 Preprocessor > -Meshing- Mesh > -

Volume Sweep- Sweep Opts 并激活四面体网
格划分.  (或使用 EXTOPT,VSWE 命令.)



网格划分

...扫掠划分

注意

• 对一个复杂形体进行 映射网格划分, 您需要对它做多次切割,做一些
连接面或连接线.  若采用 扫掠划分, 您只需做几次切割操作, 而不需
连接操作!

• 您可以利用标准的网格控制来确定源面的网格.  一般不提倡使用智
能网格划分,因为它是用于自由网格划分.



第5章 荷载施加

张强强

Email: zhangqq@lzu.edu.cn

联系方式：13659417036
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载荷分类

Objective

7-1. 列表和分类载荷

ANSYS中的载荷可分为:

• 自由度DOF - 定义节点的自由度（ DOF ） 值 (结构分析_位移、热分
析_ 温度、电磁分析_磁势等)

• 集中载荷 - 点载荷 (结构分析_力、热分析_ 热导率、电磁分析_ 

magnetic current segments)

• 面载荷 - 作用在表面的分布载荷 (结构分析_压力、热分析_热对流、
电磁分析_magnetic Maxwell surfaces等)

• 体积载荷 - 作用在体积或场域内 (热分析_ 体积膨胀、内生成热、电
磁分析_ magnetic current density等)

• 惯性载荷 - 结构质量或惯性引起的载荷 (重力、角速度等)



加载

Objective

4-2a.加载.

可在实体模型或 FEA 模型 (节点和单元) 上加载.

在关键点处
约束

实体模型

沿线均布的压力

在关键点加集中力

在节点处约束

FEA 模型

沿单元边界均布的压力

在节点加集中力



加载 (续)

+ 几何模型加载独立于有限元网格. 重新划分网格或局部网格修改不影
响载荷.

+ 加载的操作更加容易 ,尤其是在图形中直接拾取时.

直接在实体模型加载的优点:

Guidelines



加载 (续)

无论采取何种加载方式,ANSYS求解前都将载荷转化到有限元模型.因此
,  加载到实体的载荷将自动转化到 其所属的节点或单元上。

实体模型

加载到实
体的载荷
自动转化
到其所属
的节点或
单元上

FEA 模型

沿线均布的压力 均布压力转化到以线为边界
的各单元上



加载 (续)

旧版本菜单是 很长的菜单, 展示了
Ansys可以处理的多种荷载类型。

对于结构分析，部分菜单呈暗淡灰
色，表示不属于结构分析的范畴

实体模型加载:

Main Menu:  Solution > -Define Loads- Apply

步骤

1. .....

2. .....

3. .....

说明: 可通过在preferences 中选择适
当的分析类型过滤菜单中的选项。

新版本菜单是 精简的菜单, ANSYS 

从模型中的单元类型和材料性质，
识别出可施加的荷载类型。



加载 (续)

输入一个
压力值即为
均布载荷, 

两个数值
定义
坡度压力

说明：压力数值为正表示其方向指向表面

Main Menu:  Solution > -Loads- Apply > Pressure > On Lines

加载面力载荷

拾取
Line



加载 (续)

VALI = 500

VALI = 500

VALJ = 1000

VALI = 1000

VALJ = 500

500

L3

500

L3

1000

500

L3

1000
500

坡度压力载荷沿起始关键点(I) 

线性变化到第二个关键点 (J)。

如果加载后坡度的方向相反, 将
两个压力数值颠倒即可。

加载面力载荷（续）



加载 (续)

• 轴对称载荷可加载到具有对称轴的3-D 结构上。

• 3-D 轴对称结构可用一2-D 轴对称模型描述。

加载轴对称载荷

10” 直径

5” 半径

轴对称模型

3-D 结构
对称轴



加载 (续)

加载 轴对称载荷, 注意以下
方面:

– 载荷数值 (包括输出的反力) 

基于360度转角的3-D结构。

– 在右图中，轴对称模型中的
载荷是3-D结构均布面力载
荷的总量。

Total Force = 2pr = 47,124 lb.

准则

3-D 结构 2-D 有限元模型

Axis of 

symmetry



加载 (续)

在关键点加载位移约束:   

加载约束载荷

Main Menu:  Solution > -Loads- Apply -Structural-

Displacement > On Keypoints +
procedure

1. .....

2. .....

3. .....

Expansion option 可使相同的载荷加
在位于两关键点连线的所有节点上拾取

keypoints

例

要固定一边，只
要拾取关键点6、
7,并设置 all 

DOFs = 0 和
KEXPND = yes.

K6

K7



加载 (续)

加载约束载荷（续）

在线和面上加载位移约束:   

Main Menu:  Solution > -Loads- Apply -Structural-

Displacement > On Lines +  OR  On Areas+
步骤

1. .....

2. .....

3. .....



校验载荷

• 实体模型载荷显示在几何模型上
(体、面、线或关键点)

• 有限元模型载荷在画节点或单元
时显示

通过 plotting画出载荷:  

Utility Menu:  PlotCtrls > Symbols ...

或通过 listing列表载荷:

Utility Menu:  List > Loads

步骤

1. .....

2. .....

3. .....

Objective

4-2b. 校验载荷



将载荷转化到有限元模型上
说明: 只有到求解初始化时，才将模型中的载荷自动转化到有限元模
型中的节点和单元上。

Procedure

1. .....

2. .....

3. .....

下面将载荷转化到节点和单元上，不进行求解:

Main Menu:  Solution > -Loads-Operate

这些选项出现的信息大致相同



删除载荷

Main Menu:  Solution > -Loads- Delete 

All Load Data 选项可同时删除模型
中的任一类载荷。

individual entities by picking 选项
只删除模型选定的载荷。

而...

Procedure

1. .....

2. .....

3. .....

4-2c. 删除载荷
Objective



删除载荷（续）

当删除实体模型时, ANSYS 将自动删除其上所有的载荷

实体模型 FEA 模型l

删除线上的均
布压力

自动删除以线为边界
的各单元均布压力

记住这
一关系?



删除载荷（续）

两关键点的扩展位移约束载荷例外：

删除两点的约束

只删除了两角点
（ CORNER ）
约束， 而加载
时扩展的 （
inside ） 节点

约束必须手工删
除.

实体模型 FEA 模型l



求解

求解结果保存在数据库中并输出到结果文件 (Jobname.RST, 

Jobname.RTH, Jobname.RMG, or Jobname.RFL)

结果文件结果数据

数据库 求解器

结果

输入数据



求解时模型是否准备就绪?

在求解初始化前，应进行分析数据检查，包括下面内容:

• 统一的单位
• 单元类型和选项
• 材料性质参数

– 考虑惯性时应输入材料密度
– 热应力分析时应输入材料的热膨胀系数

• 实常数 (单元特性)

• 单元实常数和材料类型的设置
• 实体模型的质量特性 (Preprocessor > Operate > Calc Geom Items)

• 模型中不应存在的缝隙
• 壳单元的法向
• 节点坐标系
• 集中、体积载荷
• 面力方向
• 温度场的分布和范围
• 热膨胀分析的参考温度 (与 ALPX 材料特性协调?)



加载 & 求解

...求解器

• ANSYS 中可用的求解器可以分为三类:

– 直接消去 求解器

• 波前求解器

• 稀疏求解器 (缺省)

– 迭代求解器

• PCG (预制条件共轭梯度求解器)

• ICCG (不完全乔利斯基共轭梯度求解器)

• JCG (雅可比共轭梯度求解器)

– 并行求解器 (需要特殊的授权文件)

• AMG (Algebraic Multigrid)

• DDS (分布区域求解器)



加载 & 求解

...求解器

• 直接消去求解器求解以下内容:

1. 计算单元刚度矩阵。

2. 读取第一个单元的自由度。

3. 删除所有已知自由度或通过其它自由度可以
表示的自由度, 然后把方程写入 .tri 文件。保
留的自由度构成波前。

4. 对所有单元重复2，3步骤直到所有的自由度
都被消去。现在的 .tri 就包含了一个三角化
的矩阵。

5. 回代求解自由度,然后使用单元矩阵计算单元
解。

计算单元矩阵

组集并三角化
总体矩阵

回代求解

.emat

file

.tri

file

results

file



加载 & 求解

...求解器

• 由于自由度仍不能被排除，所以波前是对角化过程中保留在求解器
中的自由度数。它随着求解的进行增大或缩小，当最后自由度消去
完成后，波前数变为零。

• 波前直接影响到计算的速度：值越大，速度越慢。

• 重新进行单元编号 — 为求解器选择一个合适的单元编号顺序 — 可
以减小波前数。 ANSYS 在一开始就自动对单元重新编号。



加载 & 求解

...求解器

• 迭代 求解器通过以下步骤求解:

1. 计算单元刚度矩阵。

2. 组集总体刚度矩阵。

3. 开始时把所有自由度的值设为零，然后一直
迭代到收敛(基于输入的残余力的容许值)。

4. 用单元刚度矩阵计算单元解。

• 在 ANSYS 中迭代求解器和 PCG, JCG, 

ICCG 的主要区别是所使用的预条件控制
不同。

计算单元矩阵

组集总体矩阵

迭代求解

.emat

文件

.full

文件

结果
文件



加载 & 求解

...求解器
 

求解器 何时使用 
模型大小 

(DOFs) 
内存使用 

硬盘

使用 

Frontal 但要求适应性好时(非线性分析)或当内存有限时 < 50k 低 高 

Sparse 

当要求适应性和求解速度时(非线性分析); 对线性分析当

迭代求解器求解器难于收敛时(尤其是对病态矩阵,诸如形

状不好的单元) 

10k - 500k 

(对壳及梁模

型更多) 

中等 高 

PCG 
当求解速度至关重要时 (大模型的线性分析,尤其是实体单

元) 

50k - 
1000k+  

高 低 

ICCG 
当多物理场应用求解速度至关重要时。当其他迭代求解

器收敛困难(近乎不定矩阵) 

50k - 
1000k+ 

高 低 

JCG 
当单物理场问题求解速度至关重要时(热、电磁、声学及

多物理场) 

50k - 
1000k+ 

中等 低 

 



加载 & 求解

...求解器

– 并行求解器 (需特殊授权)

• AMG (代数多极运算)

– 迭代求解器可以在单处理器或多处理器环境下使用。

• DDS (Distributed Domain Solver)

– 把大模型分解为小的域，然后把这些小的域送到多处理器中处
理。



加载 & 求解

...求解器

• 选择求解器:

– Solution > -Analysis Type- Sol’n Control, 然后选择 Sol’n Options 标号

– 或者使用 EQSLV 命令

缺省是“程序选择” 求解器 [eqslv,-1], 它常常是稀疏矩阵只接求解
器。



加载 & 求解

D.  多载荷步求解

• 到现在为止, 我们已经学会了如何在一组载荷条件下求解，例如，
单载荷步求解。

– 输入或生成模型

– 网格划分

– 施加载荷

– 求解 (单载荷步)

– 观察结果



加载 & 求解

…多载荷步求解

• 如果您是在多组载荷条件下求解，可以选择
下面两种方法中的一种:

– 把所有载荷放在一起求解

– 或者分别施加载荷作为多组载荷求解。



加载 & 求解

…多载荷步求解

• 单载荷步 可定义为下列载荷条件之一

• 当使用多载荷步时，可以:

– “隔离” 结构的响应到每一种载荷条件

– 在后处理中以任何方式合并这些响应，可以研究不同的设想(这称为载
荷工况组合只对线性分析有效。在14章中论述)

• 两种定义及求解多载荷步的方式:

– 多次求解

– 载荷步文件方法



加载 & 求解

…多重载荷求解步骤

多次求解方法

• 单载荷步求解的扩展, 不离开求解器的
情况下顺序求解每一个载荷步

• 最适于批处理模式

• 当用于交互模式时，这个方法只适于
能快速求解的模型

– 输入或创建模型

– 划分网格

– 施加载荷

– 求解 (载荷步 1)

– 施加不同的载荷

– 求解 (载荷步 2)

– 施加不同的载荷

– 求解 (载荷步 3)

– 等等.

– 查看结果



加载 & 求解

…多重载荷求解步骤

载荷步文件方法

• 这种情况, 不是求解每个载荷步，写载荷
步信息到一个文件，称为载荷步文件:

– Solution > -Load Step Opts- Write LS 

File

– 或使用LSWRITE 命令

• 载荷步文件命名为jobname.s01, .s02, 

.s03, 等等

• 在所有载荷步写出后，可以只用一个命
令 — LSSOLVE 或 Solution > -Solve-

From LS Files — 顺序读入每个文件并求
解

– 输入或创建模型

– 划分网格

– 施加载荷

– 写到LS文件(.s01)

– 施加不同的载荷

– 写到LS文件(.s02)

– 施加不同的载荷

– 写到LS文件(.s03)

– 等等

– 从LS文件求解

– 查看结果



加载 & 求解

…多重载荷求解步骤

• 载荷步文件方法的优点在于可以交互建立所有载荷步在离开计算机
时求解它，甚至对大模型也可如此。

• 注意: 在载荷步文件中的加载荷命令总是按照节点和单元的，尽管
可以在实体模型上施加载荷。



加载 & 求解

…多重载荷求解步骤

• 这两种方法:

– 施加在前一个载荷步的载荷将保留在数据库中直到删除
为止。所以要确保删除不是当前载荷步的载荷

– 每一载荷步的结果附加到结果文件中去，并标识为载荷
步1，载荷步2等等

– 在后处理中，首先读入希望的结果集，然后查看

– 数据库中包含求解的最后一个载荷步的载荷及结果



进行求解(续)

没有获得结果的原因是什么?  往往是求解输入的模型不完整或存在
错误，典型原因有: 

• 约束不够 ! (通常出现的问题)。

• 当模型中有非线性单元 (如缝隙 gaps、滑块sliders、铰
hinges、索cables等），整体或部分结构出现崩溃或“松脱
”。

• 材料性质参数有负值, 如密度或瞬态热分析时的比热值。

• 未约束铰接结构，如两个水平运动的梁单元在竖直方向没有
约束。

• 屈曲 - 当应力刚化效应为负（压）时，在载荷作用下整个结
构刚度弱化。如果刚度减小到零或更小时，求解存在奇异性
，因为整个结构已发生屈曲。



第6章 求解
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模态分析

第一节： 模态分析的定义和目的

第二节： 对模态分析有关的概念、术语以及模态提取方法的讨论

第三节： 学会如何在ANSYS中做模态分析

第四节： 做几个模态分析的练习

第五节： 学会如何做具有预应力的模态分析

第六节： 学会如何在模态分析中利用循环对称性



模态分析

第一节： 定义和目的

什么是模态分析?

• 模态分析是用来确定结构的振动特性的一种技术：

– 自振频率

– 振型

– 振型参与系数 （即在特定方向上某个振型在多大程度上

参与了振动）

• 模态分析是所有动力学分析类型的最基础的内容。



模态分析

定义和目的（续上页）

模态分析的好处：

• 使结构设计避免共振或以特定频率进行振动（例如扬声器）；

• 使工程师可以认识到结构对于不同类型的动力载荷是如何响

应的；

• 有助于在其它动力分析中估算求解控制参数（如时间步长）。

建议： 由于结构的振动特性决定结构对于各种动力载荷的响应情

况，所以在准备进行其它动力分析之前首先要进行模态分

析。



通用运动方程：

• 假定为自由振动并忽略阻尼：

• 假定为谐运动：

这个方程的根是 i
， 即特征值， i 的范围从1到自由度的数目，

相应的向量是 {u}I， 即特征向量。

模态分析

第二节： 术语和概念

   ( )   02 =− uMK 

       0M u K u+ =&&

         ( ) M u C u K u F t+ + =&& &

模态分析假定结构是线性的(如, [M]和[K]保持为常数)

简谐运动方程u = u0cos(t), 其中  为自振圆周频率(弧度/秒）

注意:



模态分析

术语和概念 （续上页）

• 特征值的平方根是 i ， 它是结构的自然圆周频率（弧度/秒），并
可得出自然频率 fi = i /2p

• 特征向量 {u}i 表示振型， 即假定结构以频率 fi振动时的形状

• 模态提取 是用来描述特征值和特征向量计算的术语



模态分析 - 术语和概念

模态提取方法

• 在ANSYS中有以下几种提取模态的方法：

– Block Lanczos法

– 子空间法

– PowerDynamics法

– 缩减法

– 不对称法

– 阻尼法

• 使用何种模态提取方法主要取决于模型大小（相对于计算机的计
算能力而言）和具体的应用场合



模态分析 - 术语和概念

模态提取方法 - Block Lanczos法

• Block Lanczos 法可以在大多数场合中使用：

– 是一种功能强大的方法，当提取中型到大型模型（50.000 ~ 

100.000 个自由度）的大量振型时（40+），这种方法很有效；

– 经常应用在具有实体单元或壳单元的模型中；

– 在具有或没有初始截断点时同样有效。（允许提取高于某个给
定频率的振型）；

– 可以很好地处理刚体振型；

– 需要较高的内存。



模态分析 - 术语和概念

模态提取方法- 子空间法

• 子空间法比较适合于提取类似中型到大型模型的
较少的振型 （<40）

– 需要相对较少的内存；

– 实体单元和壳单元应当具有较好的单元形状，要对任何
关于单元形状的警告信息予以注意；

– 在具有刚体振型时可能会出现收敛问题；

– 建议在具有约束方程时不要用此方法。



模态分析 - 术语和概念

模态提取方法- PowerDynamics法

• PowerDynamics 法适用于提取很大的模型（100.000

个自由度以上）的较少振型（< 20）。这种方法明显比
Block Lanczos 法或子空间法快，但是：

– 需要很大的内存；

– 当单元形状不好或出现病态矩阵时，用这种方法可能不收敛；

– 建议只将这种方法作为对大模型的一种备用方法。

子空间技术使用Power求解器(PCG)和 一直质量矩阵；

不执行Sturm序列检查(对于遗漏模态); 它可能影响多个重复频率的
模型；

一个包含刚体模态的模型, 如果你使用PowerDynamics方法,必须执
行RIGID命令(或者在分析设置对话框中指定RIGID设置)。

注: PowerDynamics方法



模态分析 - 术语和概念

模态提取方法- 缩减法

• 如果模型中的集中质量不会引起局部振动，例如象梁
和杆那样，可以使用缩减法：

– 它是所有方法中最快的；

– 需要较少的内存和硬盘空间；

– 使用矩阵缩减法，即选择一组主自由度来减小[K] 和[M] 的大
小；

– 缩减[的刚度矩阵[K] 是精确的，但缩减的质量矩阵 [M]是近似
的，近似程度取决于主自由度的数目和位置；

– 在结构抵抗弯曲能力较弱时不推荐使用此方法，如细长的梁
和薄壳。

注意:  选择主自由度的原则请参阅<<ANSYS结构分析指
南>>.



模态分析 - 术语和概念

模态提取方法- 不对称法

• 不对称法适用于声学问题（具有结构藕合作用）和其它
类似的具有不对称质量矩阵[M]和刚度矩阵[K] 的问题：

– 计算以复数表示的特征值和特征向量

• 实数部分就是自然频率

• 虚数部分表示稳定性，负值表示稳定，正值表示不确定

注意:  不对称方法采用Lanczos算法,不执行Sturm序列检查,所以遗漏高端
频率.



模态分析 - 术语和概念

模态提取方法- 阻尼法

• 在模态分析中一般忽略阻尼，但如果阻尼的效果比较
明显，就要使用阻尼法：

– 主要用于回转体动力学中，这时陀螺阻尼应是主要的；

– 在ANSYS的BEAM4和PIPE16单元中，可以通过定义实常数
中的SPIN（旋转速度，弧度/秒）选项来说明陀螺效应；

– 计算以复数表示的特征值和特征向量。

• 虚数部分就是自然频率；

• 实数部分表示稳定性，负值表示稳定，正值表示不确定。

注意:

该方法采用Lanczos算法

不执行Sturm序列检查,所以遗漏高端频率

不同节点间存在相差

响应幅值 = 实部与虚部的矢量和



模态分析

第三节： 步骤

模态分析中的四个主要步骤：

• 建模

• 选择分析类型和分析选项

• 施加边界条件并求解

• 评价结果

建模：

• 必须定义密度

• 只能使用线性单元和线性材料，非线性性质将被忽略

• 参看第一章中有关建模要考虑的因素



模态分析步骤

选择分析类型和选项

3 建模

选择分析类型和选项：

• 进入求解器并选择模态分析

• 模态提取选项*

• 模态扩展选项*

• 其它选项*

*将于后面讨论。

典型命令：

/SOLU

ANTYPE，MODAL



模态分析步骤

选择分析类型和选项 （接上页）

模态提取选项：

• 方法： 建议对大多数情况使用
Block Lanczos 法

• 振型数目： 必须指定（缩减法
除外）

• 频率范围： 缺省为全部，但可
以限定于某个范围内 （FREQB 

to FREQE）

• 振型归一化： 将于后面讨论

• 处理约束方程： 主要用于对称
循环模态中 （以后讨论）



模态分析步骤

选择分析类型和选项 （接上页）

振型归一化：

• 因为自由度解没有任何实际意义，它只表明了振型，即
各个节点相对于其它节点是如何运动的；

• 振型可以或者相对于质量矩阵[M]或者相对于单位矩阵
[I]进行归一化：。

– 对振型进行相对于质量矩阵[M]的归一化处理是缺省选项，这种
归一化也是谱分析或将接着进行的振型叠加分析所要求的

– 如果想较容易的对整个结构中的位移的相对值进行比较，就选
择对振型进行相对于单位矩阵[I]进行归一化



模态分析步骤

选择分析类型和选项 （接上页）

模态扩展：

• 对于缩减法而言，扩展意味着从缩减振型中计算出全部振型；

• 对于其它方法而言，扩展意味着将振型写入结果文件中；

• 如果想进行下面任何一项工作，必须扩展模态：

– 在后处理中观察振型；

– 计算单元应力；

– 进行后继的频谱分析。

典型命令：

MXPAND，...



模态分析步骤

选择分析类型和选项 （接上页）

模态扩展 （接上页）：

• 建议： 扩展的模态数目应当与提取的模态数目相等，
这样做的代价最小。



模态分析步骤

选择分析类型和选项 （接上页）

其它分析选项：

• 集中质量矩阵：

– 主要用于细长梁或薄壳，或者波传播问题；

– 对 PowerDynamics 法，自动选择集中质量矩阵。

• 预应力效应：

– 用于计算具有预应力结构的模态（以后讨论）。

• 阻尼：

– 阻尼仅在选用阻尼模态提取法时使用；

– 可以使用阻尼比阻尼和阻尼；

– 对BEAM4 和 PIPE16 单元，允许使用陀螺阻尼。



模态分析步骤

施加边界条件并求解

施加边界条件并求解：

• 位移约束： 下面讨论

• 外部载荷： 因为振动被假定为自由振动，所以忽略外
部载荷。然而，ANSYS程序形成的载荷向量可以在随
后的模态叠加分析中使用

• 求解：以后讨论



模态分析步骤

施加边界条件并求解（接上页）

位移约束：

• 施加必需的约束来模拟实际的固定情况；

• 在没有施加约束的方向上将计算刚体振型；

• 不允许有非零位移约束。



模态分析步骤

施加边界条件并求解（接上页）

位移约束（接上页）：

• 对称边界条件只产生对称的振型
，所以将会丢失一些振型。

对称边界 反对称边界

完整模型



模态分析步骤

施加边界条件并求解（接上页）

位移约束（接上页）：

对于一个平板中间有孔的模型，全部模型和四分之一模型的最
小非零振动频率如下所示。在反对称模型中，由于沿着对称边
界条件不为零，所以它丢失了频率为53Hz的振型。



模态分析步骤

施加边界条件并求解（接上页）

求解：

• 通常采用一个载荷步；

• 为了研究不同位移约束的效果，可以采用多载荷
步（例如，对称边界条件采用一个载荷步，反对
称边界条件采用另一个载荷步）。

典型命令:

SOLVE



模态分析步骤

观察结果

观察结果

• 进入通用后处理器POST1

• 列出各自然频率

• 观察振型

• 观察模态应力



M2-27

模态分析步骤

观察结果（接上页）

列出自然频率：

• 在通用后处理器菜单中选择 “Results Summary”；

• 注意，每一个模态都保存在单独的子步中。

典型命令:

/POST1

SET，LIST



模态分析步骤

观察结果 （接上页）

观察振型：

• 首先采用“ First Set”、“ 

Next Set” 或“By Load 

Step”

• 然后绘制模态变形图：
shape： General Postproc > 

Plot Results > Deformed 

Shape…

• 注意图例中给出了振型序号
（SUB = ） 和频率 （FREQ 

= ）。



模态分析步骤

观察结果（接上页）

观察振型 （接上页）：

• 振型可以制作动画： Utility Menu > PlotCtrls > Animate > Mode 

Shape...



模态分析步骤

观察结果（接上页）

模态应力：

• 如果在选择分析选项时激活了单元应力计算选项，则可以得到模态应力

• 应力值并没有实际意义，但如果振型是相对于单位矩阵归一的，则可以
在给定的振型中比较不同点的应力，从而发现可能存在的应力集中。

典型命令:

PLNSOL，S，EQV

! 画von Mises应力等值图



模态分析步骤

观察结果 （接上页）

相对于单位矩
阵归一的振型



第五节： 有预应力的模态分析

什么是有预应力的模态分析？ 为什么要做有预应力的模态分析?

• 具有预应力结构的模态分析；

• 同样的结构在不同的应力状态下表现出不同的动力特性。

– 例如，一根琴弦随着拉力的增加，它的振动频率也随之增大。

– 涡轮叶片旋转时，由于离心力引起的预应力的作用，它的自然频率逐
渐具有增大的趋势。

– 为了恰当地设计这些结构，必须要做具有预应力和无预应力的模型的
模态分析。



有预应力的模态分析步骤

三个主要步骤：

• 建模

• 在静态分析中给模型施加预应力

• 做具有预应力的模态分析

建模：

• 与普通模态分析要考虑的问题一样

• 必须定义密度



有预应力的模态分析步骤

Pre-stress the Model

3 建模

• 在静态分析中给模型施加预应力

• 选择分析类型和选项：

必须激活预应力选项。

步骤：Solution>Analysis Type>Sol'n Controls > Basic

• 载荷： 施加引起预应力的载荷。

• 后处理： 观察结果，确认已经施加了合适的载荷。



有预应力的模态分析步骤

给模型施加预应力 （接上页）



有预应力的模态分析步骤
有预应力的模态分析

做具有预应力的模态分析：

• 除了在分析选项中必须激活预应力
效果选项外，其它步骤与普通模态
分析的步骤一样。
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有预应力的模态分析步骤

有预应力的模态分析（接上页）

具有预应力的平板 无预应力的平板

比较：



第7章 后处理
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后处理

概述

• 在通用后处理器(POST1)中, 有多种方法查看结果 ,有些方法前面已经述及

• 在这一章中, 我们将探索另外的两种方法 —拾取查询和路径操作— 还要为
您介绍结果转换,误差估计和载荷工况组合的概念.

• 我们也将介绍两种提高效率的工具:

– 结果查阅器

– 报告生成器

• 内容包括:

A.拾取查询 E.  载荷工况组合

B.  结果坐标系 F.  结果查阅器

C.  路径操作 G.  报告生成器

D.  误差估计 H.  专题



后处理

A.  查询拾取

• 查询拾取允许您在模型上“探测”任意拾取位置的应力,位移或其
它的结果量.

• 您还可以很快地为查询量的最大值和最小值定位.

• 仅能通过 GUI方式操作 (无命令):

– General Postproc > Query Results > Nodal or Element or Subgrid 

Solu...

– 选择某个结果量,按 OK

PowerGraphics

OFF

PowerGraphics

ON



后处理

…查询拾取

– 然后拾取模型中的任一点,以查看该点的结果值.

• Min 和 Max 将显示最大和最小点的值.

• 使用 Reset 清除所有值并重新开始拾取查询.

• 注意:实体的编号, 位置以及结果值都将显示在拾取菜单中.

自动生成文本
注释



后处理

B.  结果坐标系

• 您在POST1 中查询的所有与方向相关的量,如应力分量,位移分量和
反力分量,  都将表示在 结果坐标系 (RSYS)中.

• RSYS 的缺省值为 0 (总体坐标系).  即, POST1 在缺省时将会把所
有的结果转换到总体坐标系, 包括 “旋转” 节点的结果.

• 但有很多情况 — 诸如压力容器和球形结构— 您需要检查柱坐标系,

球坐标系或其它局部坐标系下的结果.



后处理

…结果坐标系

• 将结果坐标系变成不同的坐标系统,

使用:

– General Postproc > Options for Outp…

– 或 RSYS 命令

后续的等值图, 列表, 查询拾取等,将显示该坐标系下的结果值.

缺省 方位 RSYS,0 局部柱坐标系
RSYS,11

总体柱坐标系
RSYS,1



后处理

…结果坐标系

• RSYS,SOLU

– 设置结果坐标系为计算所用坐标系 “as-calculated.”

– 后续的等值图, 列表,拾取查询等,将显示节点和单元坐标系下的
结果值.

• 自由度解和反力为节点坐标系下的结果.

• 应力,应变等 为单元坐标系的结果.  (单元坐标系的方位与单元类型
及单元的 ESYS 属性有关.  例如对大多数的实体单元, 缺省值为总
体直角坐标系.)

– PowerGraphics下不支持



后处理

C.  路径操作

• 查看结果的另一种方法是通过路径操作, 这一方法允许您:

– 在通过模型的任意一条路径上绘图输出结果数据

– 沿某一路径进行数学运算, 包括积分和微分

– 显示一 “路径图” — 观察结果量沿路径的变化情况

• 此方法仅对包含2-D 或3-D 实体单元或壳单元的模型有效.



后处理

...路径操作

• 产生路径图的三个步骤:

– 定义一个路径

– 将数据映射到路径上

– 绘图输出数据

1.  定义一个路径

– 需要以下信息:

• 定义路径的点 (2 到 1000个).  您可以使用工作平面内的节点或特定
位置.

• 路径的曲率由激活的坐标系(CSYS)确定.

• 路径名.



后处理

...路径操作

1.  定义一个路径 (续)

– 首先激活需要的坐标系 (CSYS).

– General Postproc > Path Operations > Define Path > By Nodes or On 

Working Plane

• 拾取节点或工作平面上的特定位置以形成期望的路径,按OK

• 选取一个路径名.  在许多情况下, nSets 和 nDiv 的空上最好为缺省
值.



后处理

...路径操作

2.  将数据映射到路径上

– General Postproc > Path Operations > Map onto Path…  (或 PDEF 命
令)

• 选定需要的量, 诸如 SX.

• 为选定的量加入一个用于绘图和列表的标签.

– 如果需要,您可以显示这一路径.

• General Postproc > Path Operations > Plot Paths

• (或键入命令 /PBC,PATH,1 续之以 NPLOT 或 EPLOT命令)



后处理

...路径操作

3.  绘图输出数据

– 您既可以采用曲线图绘出路径上的量:

• PLPATH 或 General Postproc > Path Operations > On Graph...

– 或沿路径的几何形状:

• PLPAGM 或 General Postproc > Path Operations > On 

Geometry...



后处理

...路径操作

• ANSYS 允许您定义多条路径, 您只需为每条路径指定一个
唯一的路径名.  一次只能有一条路径被激活.

• 除绘图和列表外, 还有许多其它的路径功能,包括:

– 应力线性化 — 在压力容器工业中用于将沿某一路径上的应力
分解为膜应力及弯曲应力分量.

– 计算功能 — 在断裂力学中用于计算J-积分和应力集中因子.  

在热分析中用于计算越过某一路径的散失或获得的热量.

– 点积和叉积— 在电磁分析的矢量操作中有广泛应用.



后处理

D.  误差估计

• 有限元解是在 单个单元 的基础上计算应力, 即应力是在每个单元上
分别计算的.

• 然而当您在POST1中绘节点应力等值线时, 因为应力在节点上是平
均的 ,您将看到平滑的等值线.

如果绘单元解, 您将看到 未平均的 数据, 表明单元解是不连续的.

Elem 1 Elem 2

savg = 1100

s = 1200s = 1000

savg = 1200

s = 1300s = 1100

• 已平均的和未平均的应力之间的差异暗示
了网格划分的 “好”或 “差”. 这是 误差估
计 的基础.



后处理

...误差估计

• 误差估计 仅在 POST1中有效且仅适用于 :

– 线性静力结构分析和线性稳态热分析

– 实体单元 (2-D 和 3-D) 和壳单元

– 全图形模式 (非 PowerGraphics)

如果这些条件不能够满足, ANSYS 会自动关闭 误差估计计算.

• 人工激活或解除 误差估计, 使用

– ERNORM,ON/OFF

– 或 General Postproc > Options for Outp...



后处理

...误差估计

• POST1 计算如下误差估计

– 应力分析:

• 能量范数形式的百分率误差 (SEPC)

• 单元应力偏差 (SDSG)

• 单元能量误差 (SERR)

• 最大和最小应力范围 (SMXB, SMNB)

– 热分析:

• 能量范数形式的百分率误差(TEPC)

• 单元的热梯度偏差 (TDSG)

• 单元能量误差 (TERR)



后处理

...误差估计

能量范数的百分率误差(SEPC)

• SEPC 是整个选择单元序列上应力 (或位移, 温度, 或热流) 误差的
一个粗略估计.

• 可用于比较相似载荷作用下相似结构的相似模型

• SEPC 是在变形图的图例中显示的.  您可以使用PRERR 或采用
General Postproc > List Results > Percent Error进行人工列表.



后处理

...误差估计

单元应力偏差 (SDSG)

• SDSG 是单元应力与节点平均应力不一致
的量的一个量度.

• 绘SDSG等值线,您可以使用
PLESOL,SDSG 或 General Postproc > 

Plot Results > Element Solu...

• SDSG的值较大并不一定意味着模型有误, 

尤其该处应力为结构中名义应力的一个小
百分比时.

• 例如, 这一带孔板模型 显示在关心区域的
应力偏差仅为 1.5%. 关心位置的SDSG = ~450 psi, 

仅为名义应力 ~30,000 psi 的
~1.5%



后处理

...误差估计

单元能量误差 (SERR)

• SERR 是与单元节点上不匹配应力相关的能量.  它是一个基本的误
差量度,其余的误差量可由它导出.  SERR 具有能量的单位.

• 要绘 SERR 等值线, 执行 PLESOL,SERR命令或采用菜单操作
General Postproc > Plot Results > Element Solu...

• 通常, 具有最高 SERR单元的网格需要细化.  然而, 因为应力奇异点
一般具有较高的 SERR, 切记首先不要选择这些单元.



后处理

...误差估计

应力范围 (SMXB 和 SMNB)

• 应力范围能够帮助您确定网格离散化误差在最大应力上的潜在影响

• 它们在应力云图的图例中以 SMXB (上限) 和 SMNB (下限) 显示.

• 限度 并非 实际最大和最小应力的估计, 但它们定义了一个 “信度
带”.  没有其它的支持证据, 您就没有理由相信真实的最大应力小
于 SMXB.



• 警告: 如果您没有去掉（不选择）靠近应力奇异区的单元,那么应力
范围是无意义的, 如下图所示.

后处理

…误差估计

SMXB = 4,773

SMXB = 18,102



后处理

E. 载荷工况组合

• 只要您求解多载荷步, 每一载荷步的结果将以独立的序列存放在结
果文件中 (由载荷步号识别).

• 载荷工况组合是两个结果序列之间的操作, 这些序列被称为 载荷工
况.

– 操作发生在数据库中的一个载荷工况和结果文件中的第二个载荷工况
之间.

– 操作的结果 — 组合的工况 — 存放回数据库.

数据库中工况
(计算机内存)

结果文件中
工况

数据库中组合的工况
覆盖以前的内容



后处理

...载荷工况组合

典型步骤:

1. 建立载荷工况

2. 将某一 载荷工况读入数据库

3. 执行期望的操作



后处理

...载荷工况组合

建立载荷工况

• 一个载荷工况可简单地充当一个结果系列的指示器.  它
需要如下两条信息:

– 唯一的 ID 号

– 它代表的结果序列 (载荷步和载荷子步号)

• 使用 LCDEF 命令或 General Postproc > Load Case > 

Create Load Case



后处理

...载荷工况组合

将某一 载荷工况读入数据库 (内存)

• 简单地采用载荷工况号识别结果序列 ,使用 LCASE 

命令或 General Postproc > Load Case > Read 

Load Case.

• 或在后处理中使用一个标准的 “读结果”选择 (SET

命令). 



后处理

...载荷工况组合

执行期望的操作

• 许多有效的操作如这里的菜单所示

• 使用 LCOPER 命令或 General Postproc > Load 

Case > Add, Subtract, 等.

• 切记操作的结果存放在数据库 (内存)中.  组合后的载
荷工况在绘图和列表时由序号9999识别.



后处理

...载荷工况组合

• 有两种有用的选项用于存储组合的载荷工况 :

– 写一个 载荷工况文件

– 将载荷工况添加到结果文件

• 写一个 载荷工况文件 (LCWRITE 或 General 

Postproc > Write Results) 产生一个与结果文件相似,

但比它小得多的文件.

• 添加 选项 (RAPPND 或 General Postproc > Load 

Case > Write Load Case) 允许您将组合的载荷工况

添加到结果文件并用一给定的载荷步号和时间值识
别.



后处理

F.  结果查阅器

• 结果查阅器是一个 专门的后处理
菜单 和图解系统.

– 大模型或有许多时间步模型的快
速绘图

– 容易地利用菜单系统快速查阅结
果



• 可以采用两种方法产生 …

– 求解过程中,在写一个jobname.pgr文件前,

使用 POUTRES 命令.

– Solution > Output Cntrls > PGR file…

后处理

… 结果查阅器

按住 CTRL 键进行
多选



后处理

… 结果查阅器

– 在求解结束后写jobname.pgr 文件时使用
PGWRITE 命令.

– General Postproc > Write PGR File…



后处理

… 结果查阅器

• 在通用后处理器中打开结果查阅器.



单元图

节点/单元/矢量/迹线
结果图

结果查询

用 PNG文件
动画

结果列表 捕捉/打印
图象

结果序列
位置指示

后处理

... 结果查阅器



• 图形窗口变成 “上下文相关的”.

后处理

... 结果查阅器

在模型上单击鼠标右键

上下文相关的图形窗口



后处理

... 结果查阅器

在图例上单击鼠标右键

上下文相关的图形窗口



后处理

... 结果查阅器

上下文相关的图形窗口

在等值条上单击鼠标右键



后处理

G. 报告生成器

• 任何分析中的一项费时的工作
是整理模型和结果的文档.  这一
过程可通过执行ANSYS的报告
生成器部分自动化完成..

• 报告生成器允许用户快速捕捉
图片, 列表, 表格, 和其它有关的
信息.

• 它也可以便利地生成一个
HTML 格式文件 以便同事使用
或 在网站上发布.



后处理

… 报告生成器

• 登陆报告生成器 将最小化图形窗口并将
背景设成白色.

• “捕捉工具” 将打开允许用户捕捉图形, 

列表,和表格.

– Utility Menu> File> Report Generator…

或

– ~eui,’euidl::报告::工具条::创建’

捕捉工具



图象捕捉

(单个 PNG 文件)

动画捕捉

(多个 PNG 文件)

表格捕捉

设置

HTML 报告
汇编程序

列表捕捉

后处理

… 报告生成器

记录文件全部捕捉!

• 捕捉工具



后处理

… 报告生成器

HTML 组装器 . . .

• 允许快速组织ANSYS 图形, 表格, 

列表的工具 .

• 记录文件可用作 HTML的模板.

– 利用参数置换

• 生成的 HTML 文件可以与
Netscape浏览器，微软FrontPage

或其它的 HTML 编辑器一起使用完
成报告.



后处理

… 报告生成器

• 插入 TEXT

• 插入任何 HTML 文件

– 可在 ANSYS之外生成

• 插入图象

– 可插入一个象数码相片一样的外部
图象

• 插入 动态数据

– ANSYS运行过程中特定的信息,如
版本,运行时间等.

• 插入一个报告标题

– 包括您的姓名, 分析标题, 日期, 和
公司名称



后处理

… 报告生成器

• 插入利用捕捉工具捕捉到的信息

• 报告图象

– 等值线图, 单元图, 体图, 曲线图

• 报告表格

– 材料特性, 反力等. 

• 报告列表

– 沿路径的应力, 约束情况等. 



后处理

… 报告生成器

• 报告预览

• 删除报告的某些部分

• 将报告的某些部分上下移动



后处理

… 报告生成器

动态数据



ANSYS 分析案例



1. 桁架结构静力分析

如图所示，已知下承式简支钢桁架桥桥长72m，

每个节段12m，桥宽10m，高16m。设桥面板为

0.3m厚的混凝土板。桁架杆件规格有3种，见表1-1。

12*6=7

2

1
6

钢桁架桥简图

表1-1  钢桁架桥杆件规格

表1-2  材料属性

所用材料属性见表1-2。

杆件 截面号 形状 规格

端斜杆 1 工字形 400×400×16×16

上下弦 2 工字形 400×400×12×12

横向连接梁 2 工字形 400×400×12×12

其他腹杆 3 工字形 400×300×12×12

参数 钢材 混凝土
弹性模量EX 2.1×1011 3.5×1010

泊松比PRXY 0.3 0.1667

密度DENS 7850 2500



2. 桁架结构模态分析

如图所示，已知下承式简支钢桁架桥桥长72m，

每个节段12m，桥宽10m，高16m。设桥面板为

0.3m厚的混凝土板。桁架杆件规格有3种，见表1-1。

12*6=7

2

1
6

钢桁架桥简图

表1-1  钢桁架桥杆件规格

表1-2  材料属性

所用材料属性见表1-2。

杆件 截面号 形状 规格

端斜杆 1 工字形 400×400×16×16

上下弦 2 工字形 400×400×12×12

横向连接梁 2 工字形 400×400×12×12

其他腹杆 3 工字形 400×300×12×12

参数 钢材 混凝土
弹性模量EX 2.1×1011 3.5×1010

泊松比PRXY 0.3 0.1667

密度DENS 7850 2500



3. 边坡稳定性

边坡实例采取国内某矿，该边坡考虑弹性和塑性两种材料，边

坡尺寸如图2-1所示。分析目的是对该边坡进行稳定性计算分析，以

判断其稳定性和计算出安全系数，该边坡围岩材料属性见表2-1。

边坡模型

378米

800米

400米

800米 430米 1200米

边坡围岩2弹塑性材料

边坡围岩1弹性材料

类别 弹性模量/Gpa 泊松比ν重度/（kN/m3） 内聚力/Mpa 摩擦角ϕ（。）

围岩2（弹塑性） 30 0.25 25 0.9 42

围岩1（弹性） 31 0.24 27 - -

围岩2（弹塑性） 30 0.25 25 - -

围岩1（弹性） 31 0.24 27 - -

对于像边坡这样纵向很长的实体，计算模型可以简化为平面应变问题。假定边坡所承受的外力不随Z轴变

化，位移和应变都发生在自身平面内。对于边坡变形和稳定性分析，这种平面假设是合理的。实测经验表明，

边坡的影响范围在2倍坡高范围，因此计算区域为边坡体横向延伸2倍坡高，纵向延伸3倍坡高。两侧边界水平

为零，下侧边界竖向位移为零。弹性有限元的计算模型如图2-1所示。

采用双层模型，模型上部为理想弹塑性材料，下部为弹性材料，左右边界水平位移为零，下边界竖向位

移为零。

（1）双层模型考虑土体的弹塑性变形，其塑性区的发展，应力的分布更符合实际情况。

（2）考虑双层模型，塑性区下部的单元可以产生一定的垂直变形和水平变形，基本消除了由于边界效应

在边坡下部出现的塑性区，更好地模拟了边坡的变形和塑性区的发展。



4. ANSYS重力坝抗震性能实例分析

实力选取应用非常广泛的重力坝，断面结构如图

11-3所示。坝高120m，坝底宽为76m，坝顶为10m，

上游坝面坡度和下游坝面坡度如图中所示。

因为重力坝结构比较简单，垂直长度方向的断面结

构手里分布也基本相同，并且大坝的纵向长度远大于

其横断面，因此大坝抗震性能分析选用单位断面进行

平面应变分析是可行的。

大坝抗震性能分析的计算条件如下：

（1）假设大坝的基础是嵌入基岩中，地基是刚性的。

（2）大坝采用的材料参数为：弹性模量 E=35GPa，

泊松比ν=0.2，容重γ=25kN/m3.

（3）计算分析大坝水位为120m。

（4）水的质量密度为1000kg/m3。

（5）大坝设防地震烈度为8，水平方向地震加速度

值为0.2g。

10

1
2
0

1

0.05

1

0.6



5. 隧道工程实例分析

某铁路上的别岩槽隧道某断面。该断面设计单位采用的

支护结构如图所示。为保证结构的安全性，采用了荷

载—结构模型。利用ANSYS对其进行计算分析。

主要参数如下：

隧道腰部和顶部衬砌厚度是65cm，隧道仰拱衬砌厚度为

85cm。

采用C30钢筋混凝度为衬砌材料。

隧道围岩是IV级，洞跨5.36m，深埋隧道。

隧道仰拱下承受水压，水压0.2MPa。

隧道围岩级别IV级，其物理力学指标级衬砌材料C30钢

筋混凝土物理力学指标见表1。

根据《铁路隧道设计规范》，可计算出深埋隧道围岩

的垂直均布力和水平均布力。对于竖向和水平的分布荷

载，其等效节点力分别近似的取节点两相邻单元水平或

垂直投影长度的一般衬砌计算宽度这一面积范围内的分

布荷载总和。自重荷载通过ANSYS程序直接添加密度施

加。隧道仰拱部收到的水压0.2MPa，按照径向方向荷载

置换为等效节点里，分解为水平竖直方向加载，见表2。

荷载种
类

围岩压力

结构自重 水压/(N/m3)垂直均
布力

/(N/m3)

水平均布力
/(N/m3)

C30钢
筋混凝

土
80225 16045-

通过ANSYS添
加

200000

表2

名称
重度
γ/(Kn/

M3)

弹性抗
力系数
K/(MP

a/m)

弹性模
量

E/GPa

泊松比
ν

内摩擦
角

φ(°)

凝聚力
C/MPa

IV级围
岩

22 300 1.5 0.32 29 0.35

C30钢
筋混凝
土

25 - 30 0.2 54 2.42

表1



6. 三层框架结构地震响应分析

某板梁结构，计算在Y方向的地震位移响应谱作用下整个结构的响应
情况，板梁结构立面图和侧面图的基本尺寸如图13-13所示，地震谱见
表13-2，其他数据如下：

材料是A3钢，弹性模量 2e11 N/m2 ，泊松比0.3，密度 7.8e3 kg/m3 。
板壳厚度 2e-3 m。

梁几何性质：截面面积 1.6e-5 m2，惯性矩64/3 e-12 m4 ,宽度4e-3 m,
高度4e-3m。

响应谱

频率/Hz 位移/103 m

0.5 1.0

1.0 0.5

2.4 0.9

3.8 0.8

17 1.2

18 0.75

20 0.86

32 0.2



7. 框架结构模拟建模

已知框架结构的平面图，立面图，侧面图如图13-44所示。
楼板和屋盖厚度200mm,框架柱截面0.5x0.5m,横梁截面0.3x0.6m。

20 20 6

4

2 6

4

4

6

2

6

4

4

4

平面 侧面 立面

框架结构尺寸简图
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